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ROSEMOUNT

Rosemount 5400 Series

NOTICE

Read this manual before working with the product. For personal and system safety, and for
optimum product performance, make sure you thoroughly understand the contents before
installing, using, or maintaining this product.

Within the United States, Rosemount Inc. has two toll-free assistance numbers.

Customer Central: 1-800-999-9307(7:00 a.m. to 7:00 p.m. CST)
Technical support, quoting, and order-related questions.

North American Response Center:
Equipment service needs.
1-800-654-7768 (24 hours a day — Includes Canada)

For equipment service or support needs outside the United States, contact your local
Rosemount representative.

There are no health hazards from the Rosemount 5400 Series transmitter. The microwave
power density in the tank is only a small fraction of the allowed power density according to
international standards.

ACAUTION

The products described in this document are NOT designed for nuclear-qualified
applications.

Using non-nuclear qualified products in applications that require nuclear-qualified hardware
or products may cause inaccurate readings.

For information on Rosemount nuclear-qualified products, contact your local Rosemount
Sales Representative.

This product is designed to meet FCC and R&TTE requirements.

This device complies with part 15 of the FCC rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Rosemount 5400 Series Radar Transmitter may be protected by one or more U.S. Patents pending and foreign
patents pending.

Rosemount and the Rosemount logotype are registered trademarks of Rosemount Inc.

HART is a registered trademark of the HART Communication Foundation.

Teflon, VITON, and Kalrez are registered trademarks of DuPont Performance Elastomers.

AMS Suite is a trademark of Emerson Process Management.

FOUNDATION is a trademark of the Fieldbus Foundation.

Cover Photo: 5400_08, 5400_Process_Seal.tif, 5400_Rod.tif
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Section 1 Introduction

Safety Messages . ... page 1-1

Manual Overview . ...........oiiiiiiiiiiin. page 1-2

Service SUPPOrt . ... page 1-3
SAFETY MESSAGES Procedures and instructions in this manual may require special precautions to

ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (4). Refer to
the safety messages listed at the beginning of each section before performing
an operation preceded by this symbol.

Failure to follow these installation guidelines could result in death or serious
injury.
« Make sure only qualified personnel perform the installation.

« Use the equipment only as specified in this manual. Failure to do so may
impair the protection provided by the equipment.

Explosions could result in death or serious injury.

« Verify that the operating environment of the transmitter is consistent with the
appropriate hazardous locations certifications.

« Before connecting a 275/375 Handheld Communicator in an explosive
atmosphere, make sure the instruments in the loop are installed in accordance
with intrinsically safe or non-incendive field wiring practices.

Electrical shock could cause death or serious injury.
« Use extreme caution when making contact with the leads and terminals.

AWARNING

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution
of components etc., may also jeopardize safety and is under no circumstances allowed.

ROSEMOUNT EMERSON

Process Management

Wwww.rosemount.com
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MANUAL OVERVIEW

1-2

This manual provides installation, configuration and maintenance information
for the Rosemount 5400 Series Radar Transmitter.

Section 2: Transmitter Overview

* Theory of Operation

» Descripton of the transmitter

* Process and vessel characteristics

Section 3: Installation

* Mounting considerations
* Mechanical installation

» Electrical installation

Section 4: Configuration/Start-Up

» Configuration instructions

» Configuration using the RRM software

» Configuration using a 275/375 Field Communicator

Section 5: Operation
* Viewing measurement data with a Display panel
* Viewing measurement data with Rosemount Radar Master

Section 6: Service and Troubleshooting
e Troubleshooting

» Error and Warning Codes

» Communication Errors

Appendix A: Reference Data
e Specifications
» Ordering Information

Appendix B: Product Certifications

» Examples of labels

» European ATEX Directive information
* FM approvals

» CSA approvals

» Drawings

Appendix C: Advanced Configuration
» Advanced Tank Geometry
» Advanced Transmitter Configuration
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SERVICE SUPPORT

To expedite the return process outside of the United States, contact the
nearest Rosemount representative.

Within the United States, call the Rosemount National Response Center using
the 1-800-654-RSMT (7768) toll-free number. This center, available 24 hours
a day, will assist you with any needed information or materials.

The center will ask for product model and serial numbers, and will provide a
Return Material Authorization (RMA) number. The center will also ask for the
process material to which the product was last exposed.

Rosemount National Response Center representatives will explain the
additional information and procedures necessary to return goods exposed to
hazardous substance can avoid injury if they are informed of and understand
the hazard. If the product being returned was exposed to a hazardous
substance as defined by Occupational Safety and Health Administration
(OSHA), a copy of the required Material Safety Data Sheet (MSDS) for each
hazardous substance identified must be included with the returned goods.

1-3
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Section 2 Transmitter Overview

Theory of Operation ........... ... .. .. .. . ..., page 2-1
Components of the Transmitter .................... page 2-2
System Architecture ......... ... page 2-3
Process Characteristics ........... ... .. ... ... page 2-4
Antenna Selection Guide/Measuring Range .......... page 2-5

THEORY OF OPERATION  The Rosemount 5400 Series Radar Transmitter is a smart, two-wire
continuous level transmitter. A 5400 transmitter is installed at the tank top and
emits short microwave pulses towards the product surface in the tank. When
a pulse reaches the surface of the material it is measuring, part of the energy
is reflected back to the antenna for subsequent processing by the transmitter
electronics. The time difference between the transmitted and reflected pulse
is detected by a micro-processor and is converted into a distance from which
the level is calculated.

The product level is related to the tank height and the measured distance by
the following expression:

Level=Tank Height - Distance.

Figure 2-1. Measurement

principle for the 5400 Series. Signal amplitude
y
=
T Distance
®
7]
E i
,,7,, | )
Radar pulse | —— S >
w
-
a
o
Level z
= &
3 o
y A~ | 2
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COMPONENTS OF THE The Rosemount 5400 Series Radar Transmitter has a die-cast aluminum
TRANSMITTER housing which contains advanced electronics for signal processing.

The radar electronics produces the electromagnetic pulse that is emitted
through the antenna. There are different antenna types and sizes available for
various applications.

The transmitter head has separate compartments for electronics and
terminals. The head can be removed without opening the tank. The head has
two entries for conduit/cable connections.

The tank connection consists of a Tank Seal and a flange
(ANSI, EN (DIN) or JIS).

Figure 2-2. Transmitter
components.

Display Panel Terminal side

Cable Entry: ——
" NPT.
Optional adapters: M20

N
|| <¢——— CableEntry:

U " NPT.

Optional adapters: M20

Transmitter Head with

Tank Seal — g Radar Electronics

Flange ———p» I

Antenna

TRANSMITTER_COMPONENTS.EPS
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SYSTEM
ARCHITECTURE

Figure 2-3. System Integration.

Rosemount 5400 Series
Radar Transmitter

&

The 5400 Series Radar Level Transmitter is a powerful radar level transmitter
suitable for non-contact level measurements in process tanks and other types
of tanks. It is designed for easy installation and maintenance free operation.

The Rosemount 5400 Series Radar Transmitter is loop-powered which
means it uses the same two wires for both power supply and output signal.
The output is a 4-20 mA analog signal superimposed with a digital HART
signal.

Display (optional)

Control System

I

HART [D]
Modem
L
T e—=
275 HART 375 Field Communicator PC with

Communicator

RRM or AMS Suite

SYSTEM_5400.EPS

The Rosemount 5400 Series Radar Transmitter can easily be configured by
using a PC and the Rosemount Radar Master (RRM) software package or via
a 275/375 Handheld Communicator. RRM offers configuration and service
capabilities and functions for presentation of measurement data. The
transmitter is also compatible with the AMS™ Suite software which can be
used for configuration.

For stand-alone systems, or as a complement to a PC or a control system,
you can monitor level data using an analog output. As an option, the
Rosemount 5400 Series Radar Level Transmitter can be equipped with a
Display for monitoring measurement data.

2-3



Reference Manual
. 00809-0100-4026, Rev DA
Rosemount 5400 Series March 2006

PROCESS
CHARACTERISTICS

Dielectric constant The reflectivity of the product is a key parameter for measurement
performance. A high dielectric constant of the media gives better reflection
and thus enables a longer measuring range.

Foam How well the Rosemount 5400 Series Radar Transmitter measures in foamy
applications depends upon the properties of the foam; light and airy or dense
and heavy, high or low dielectrics, etc. If the foam is conductive and creamy
the transmitter will probably measure the surface of the foam. If the foam is
less conductive the microwaves will probably penetrate the foam and
measure the liquid surface.

Turbulence A calm surface gives better reflection than a turbulent surface. For turbulent
applications, the maximum range of the radar transmitters is reduced. The
range is dependent upon the frequency, the antenna size, the dielectric of the
material and the degree of turbulence. Consult tables 2-1and 2-2 for the
expected maximum range with the variables listed.

Temperature/Pressure/ Temperature and pressure generally have no impact on measurements.
Density and Vapor Measurements are also insensitive to product density and vapor.
Condensation For applications where heavy condensation and vapors may occur the low

frequency version Rosemount 5401 is recommended.

Tank Characteristics The conditions inside the tank have a significant impact on measurement
performance. For more information see “Vessel Characteristics” on page 3-9.

2-4
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ANTENNA SELECTION
GUIDE/MEASURING
RANGE

Table 2-1. Measuring range for
the Rosemount 5401 model.

Table 2-2. Measuring range for
the Rosemount 5402 model.

The measuring range primarily depends on the antenna type and size, the
dielectric constant (g,) of the liquid and process conditions. For optimum
performance, make sure not to exceed the maximum measuring range values
below.

A. Oil, gasoline and other hydrocarbons, petrochemicals (¢, =1.9-4.0).

B. Alcohols, concentrated acids, organic solvents, oil/water mixtures and
acetone (g, =4.0-10.0).

C. Conductive liquids, e.g. water based solutions, dilute acids and alkalis
(e,>10.0).

Low
Frequency
Device

Units: ft (m)

Dielectric Constant

NA

Cone, 3in® NA NA 66 (20) | 66 (20) | 66 (20)

Cone, 4 in/ 20 (6) | 33(10) | 43(13) | 66(20) | 66 (20) | 66 (20) | 9.9(3) | 16(5) |23(7)
Rod®@

Cone, 6in 33(10) | 49 (15) | 66 (20) | 66 (20) | 66 (20) | 66(20) | 16 (5) | 23(7) | 30(9)
Cone, 8in 49 (15) | 66(20) | 98(30) | 66 (20) | 66 (20) | 98(30) |23(7) |30(9) | 36(11)

(1) Pipe installations only. NA=Not Applicable.
(2) Pipe installations are not allowed with Rod antennas.

High
Frequency
Antennas

Units: ft (m)

Dielectric Constant

Cone, 2in/ 16 (5)
Process Seal®

Cone, 3in/ 33 (10) 49 (15) 66 (20) 66 (20) 66 (20) 66 (20) 9.8 (3) 13 (4) 20 (6)
Process Seal®
Cone, 4 in/ 49 (15) 66 (20) 98 (30) 66 (20) 66 (20) 98 (30) 13 (4) 20 (6) 26 (8)
Process Seal®

33 (10) | 49 (15) | 66(20) | 66(20) | 66 (20)

(1) Pipe installations are not allowed with Process Seal antennas.

2-5
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Section 3

SAFETY MESSAGES

ROSEMOUNT

Installation

Safety Messages . ... page 3-1
Installation Procedure ......... ... ... .. ... .. ... .... page 3-2
Mounting Considerations ......................... page 3-3
Mechanical Installation ................ ... .. ... ... page 3-10
Electrical Installation ............................. page 3-15

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (4A.). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

AWARNING

Explosions could result in death or serious injury:

Verify that the operating environment of the transmitter is consistent with the appropriate
hazardous locations certifications.

Before connecting a HART-based Field Communicator in an explosive atmosphere,
make sure the instruments in the loop are installed in accordance with intrinsically safe
or non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

AWARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

AWARNING

High voltage that may be present on leads could cause electrical shock:

Avoid contact with leads and terminals.

Make sure the main power to the 5400 transmitter is off and the lines to any other
external power source are disconnected or not powered while wiring the gauge.

To prevent ignition of flammable or combustible atmospheres, disconnect power before
servicing.

Antennas with non-conducting surfaces (e.g. Rod antenna and All PTFE antenna) may
generate an ignition-capable level of electrostatic charge under extreme condtions.
Therefore, when the antenna is used in a potentially explosive atmoshpere, appropriate
measures must be taken to prevent electrostatic discharge.

EMERSON.
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INSTALLATION
PROCEDURE

3-2

Follow these steps for proper installation:

Review Installation
Considerations
(see page 3-3)

!

Mount the transmitter
(see page 3-10)

y

Wire the transmitter
(see page 3-15)

v

Make sure covers
and cable/conduit
connections are
tight.

v

Power Up the
transmitter

N

Configure the
transmitter
(see page 4-1)

Verify measurements
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MOUNTING Before you install a Rosemount 5400 Series transmitter, be sure to consider

CONSIDERATIONS specific mounting requirements, vessel characteristics and process
characteristics.

Socket Recommendation  The Rosemount 5400 Series is mounted on a nozzle by using appropriate
flanges. For best performance it is recommended that the socket meets the
following recommendations:

Figure 3-1. Mounting of the 5400
Series transmitter.

>0.4 inch/
10 mm SR

Minimum Diameter

SOCKETREQ_M.EPS

Minimum Diameter

Minimum Diameter

Table 3-1. Requirements on

socket height and width. Antenna L oy inch (mm) Min. Diameter
inch (mm)
Cone 4 in. 5.5 (140) 3.8 (97)
Cone 6 in. 6.9 (175) 5.7 (145)
Cone 8in. 10.2 (260) 7.6 (193)
Rod (short) 4.0 (100) 1.5(38)
Rod (long) 10 (250) 1.5(38)
Antenna L max inch (mm) Mlirrl.clr?l?r;nn?t)er
Cone 2in. SST 6.1 (155) 2.2 (55)
Cone 2 in. Hastelloy®, Monel® 5.5 (140) 2.2 (55)
Cone 3in. SST 5.5 (140) 2.8(72)
Cone 3 in. Hastelloy®, Monel® 6.5 (165) 2.8 (72)
Cone 4in. SST 8.5 (215) 3.8(97)
Cone 4 in. Hastelloy®, Monel® 9.4 (240) 3.8 (97)
Process Seal 2 in. 19.7 (500) 2.0 (51)
Process Seal 3 in. 19.7 (500) 3.0 (77)
Process Seal 4 in. 19.7 (500) 4.0 (102)

3-3
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3-4

Install the transmitter as follows:

Align the antenna vertically.

Choose as large antenna diameter as possible. A larger receiving area
concentrates the radar beam and ensures maximum antenna gain.
Increased antenna gain means greater margin for weak surface
echoes. A larger antenna also results in smaller beam angle and
thereby, less interference from any internal structures in the tank.

For best measurement performance, the antenna should extend below
the nozzle 0.4 inches (10 mm) or more.

In exceptional cases the Rosemount 5402 can be installed in nozzles
which don't fulfill the recommendations in Table 3-1. In those cases the
5402 with 3-in. and 4-in. antennas can be installed in nozzles with an
unobstructed length of up to 39 in. (1 m). The 2-in. antenna may be
used in nozzles where the total length is less than 12 in. (0.3) m.
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Free Space

Figure 3-2. Free space
recommendations.

Rod Antenna

For easy access to the transmitter make sure that it is mounted with sufficient

service space.

Mounting close to a tank wall, nozzle or obstruction may have a negative
influence on measurement perfomance. For maximum measurement
performance the transmitter should be mounted according to the following

recommendations:

B
C { C
_—
|
I
|
} D
;
Cone Antenna
Service space
A Cone, Rod, Process Seal
Cone, Rod

B
Process Seal

C. Inclination

Cone, Rod, Process Seal

D. Minimum distance to tank wall
Cone antenna, 5401

Cone antenna, 5402

Rod antenna, 5401

Process Seal, 5402

FREESPACE_M.EPS

Process Seal Antenna

Distance inch (mm)

20 (500)

24 (600)

33 (850)
Maximum angle

30

Distance inch (mm)

20 (500)

10 (250)

20 (500)

10 (250)
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Recommended Mounting  When finding an appropriate mounting position for the transmitter the
Position conditions of the tank must be carefully considered. The transmitter should be
mounted so that the influence of disturbing objects is reduced to a minimum.

Figure 3-3. It is important to
consider the proper mounting
position.

00000

MOUNTING_RESTRICTIONS.EPS

« Disturbing objects and filling inlets creating turbulence should be kept
at a distance, outside the signal beam (see Figure 3-4 for beamwidth
information).

» Avoid installing the transmitter at the center of the tank roof.

» A bridle / still pipe can be used to avoid interference from disturbing
objects, turbulence or foam.
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Beamwidth

Figure 3-4. Beamwidth at
various distances from the
flange.

Table 3-2. Beamwidth for the
Rosemount 5401 model.

Table 3-3. Beamwidth for the
Rosemount 5402 model.

The following recommendations should be considered when mounting the

transmitter:

* The transmitter should be mounted with as few internal structures as
possible within the beam angle.

» The flat tank wall can be located within the antenna beam angle as long
as there is a minimum distance from the transmitter to the tank wall
(see Figure 3-2 for preferred installation).

Distance

Distance

5401
(low frequency)

5402

(high frequency)

Antenna

BEAM_DIAMETER_2.EPS

4'”'(D'/\'Ri%0)cone 6in. (DN 150) Cone | 8in. (DN 200) Cone

Beam Diameter, ft (m)

16 ft (5 m) 11.5 (3.5) 6.6 (2.0) 4.9 (1.5)
33 ft (10 m) 23.0 (7.0) 13.1 (4.0) 9.8 (3.0)
49 ft (15 m) 32.8 (10) 19.7 (6.0) 14.8 (4.5)
66 ft (20 m) 427 (13) 26.2 (8.0) 19.7 (6.0)
99 ft (30 m) 65.7 (20) 39.3 (12) 29.5 (9.0)

Distance

Antenna

2in. (DN 50) Cone/ | 3in. (DN 80) Cone/ | 4in. (DN 100) Cone/
Process Seal Process Seal Process Seal

Beam Diameter, ft (m)

16 ft (5 m) 4.9 (1.5) 3.3(1.0) 3.3 (1.0)
33 ft (10 m) 9.8 (3.0) 6.6 (2.0) 4.9 (15)
49 ft (15 m) 14.8 (4.5) 9.8 (3.0) 8.2 (2.5)
66 ft (20 m) 19.7 (6.0) 13.1 (4.0) 9.8 (3.0)
99 ft (30 m) 29.5 (9.0) 19.7 (6.0) 14.8 (4.5)
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Figure 3-5. Beam angle.

BEAMWIDTH2.EPSS

Table 3-4. Beam Angle for the
Rosemount 5401.

Antenna Half Power Beam Width
3in. Cone (Still Pipe)
4 in. Cone / Rod 37°
6 in. Cone 23°
8in. Cone 17°

Table 3-5. Beam Angle for the

Rosemount 5402. Antenna Half Power Beamwidth
Cone 2in./ R
Process Seal 19
Cone 3in./ o
Process Seal 14
Cone 4in./ 9
Process Seal
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Vessel Characteristics

Disturbing Objects

Heating coils, agitators and other objects in the tank may lead to disturbing
echoes and noise in the measurement signal. Vertical structures cause
minimal effect since the radar signal is scattered rather than directed back to
the antenna.

The shape of the tank bottom affects the measurement signal when the
product surface is close to the tank bottom. The Rosemount 5400 Series has
built-in functions which optimize measurement performance for various
bottom shapes (see “Tank Type and Tank Bottom Type” on page 4-4).

The Rosemount 5400 Series transmitter should be mounted so that objects
such as heating coils, ladders, etc. are not within the radar signal path. These
objects may cause false echoes resulting in reduced measurement
performance. However, the transmitter has built-in functions designed to
reduce the influence from disturbing objects in case such objects can not be
totally avoided.

The Rosemount 5402 with its more narrow radar beam is particularly suitable
in installations that have tall or narrow nozzles or nozzles close to the tank
wall. It may also be used to avoid disturbing objects in the tank.
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MECHANICAL Mount the transmitter on a nozzle on top of the tank. Make sure only qualified
INSTALLATION personnel performs the installation.

A The transmitter housing must not be opened. If a software update or other
service action is required that involves opening the housing, it must be done
by a suitably trained service technician. Maintenance work that involves
opening the housing must not be done when the transmitter is mounted on the
tank.

If the transmitter housing must be removed for service, make sure that the
Teflon® sealing is carefully protected against dust and water.

Figure 3-6. Mounting the 5400
with cone antenna and flange.

1. Place a gasket with thickness and of
material suitable to the process on top of
the tank flange.

2. Lower the transmitter with antenna and
flange into the tank nozzle.

Transmitter housing

3. Tighten the bolts and nuts with sufficient

Bolts torque regarding flange and gasket
choice. See also “Process Temperature
_— Flange and Pressure Rating” on page A-3.
0 Cone antenna
m
8
<Z( / Gasket
-
I-LI —
T
::| Tank flange
Z Nuts ——— i)
o
=
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Figure 3-7. Mounting the 5400
with rod antenna and threaded
tank connection.

Transmitter housing
A

Nut

MOUNT_TH_ROD_THREADED.EPS

Figure 3-8. Mounting the 5400
with rod antenna and flange.

Transmitter housing
—

Bolt——— g

@
=

Sealant on threads

Antenna

.

PFA plate
(only All PFA version, —
1R, 2R)

Gasket
(optional for the
All PFA version)

Nut —— 1

MOUNT_ROD_FLANGE.EPS

Tank flange

Rod antenna

1. Lower the transmitter and antenna into
the tank.

2. Screw the transmitter into the process
connection.

NOTE!
For adapters with NPT threads, pressure-tight
joints require a sealant.

1. Place a gasket with thickness and of
material suitable to the process on top of
the tank flange.

Note! For the All PFA version (tank
sealing model code=PD) gasket is
optional.

2. Lower the transmitter with antenna and
flange into the tank nozzle.

3. Tighten the bolts and nuts with sufficient
torque regarding flange and gasket
choice. See also “Process Temperature
and Pressure Rating” on page A-3.
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Figure 3-9. Mounting the 5400
with Process Seal.

3.
Bolts
4.
— Flange 5.

o

—— O-rings

Nuts

MOUNT_PROCESS_SEAL.EPS

Table 3-6. Tightening torque for
Process Seal flanges.

T

ocess window

. Put the two O-rings into the

corresponding grooves on the antenna
process window. See Table A-2 on
page A-4 for more information on
temperature range for the O-rings.

Place the antenna on top of the nozzle.

Mount the flange and tighten the bolts
cross-wise according to Table 3-6.

Mount the transmitter head and tighten
the nut to 60 Nm.

Retighten the flange bolts after 24 hours.

Flange Torque (Nm)
2 inch, 150lbs 80
2 inch, 300lbs 80
3inch, 150lbs 80
3inch, 300lbs 125
4 inch, 150 Ibs 80
4 inch, 300 lbs 125
DN 50 PN 40 109
DN 80 PN 40 109
DN 100 PN 16 109
DN 100 PN 40 135
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Mounting in Pipes Still Pipe mounting is recommended for tanks where surface conditions are
extremely turbulent. All cone antenna sizes for the Rosemount 5400 Series of
transmitters can be used for Still Pipe installations. The 3 inch antenna for the
5401 is designed for use in Still Pipes and Bypass Pipes only. Process Seal
and Rod antennas are not recommended for Still Pipes.

When the transmitter is mounted in a Still Pipe the inclination should be
within 1°. The gap between the antenna and the Still Pipe may be up to 0.2 in.
(5 mm).

Figure 3-10. Mount the
transmitter vertically.

(7]
o
i
N
>
xl
O O z
E\_ “/:I 2
a
%
2
i
n
o
L
24
LLIl
a
%
max. 0.2 inch —| |~ =
(5 mm) %
Recommendations for pipe installations
» The pipe must be smooth on the inside.
* Not suitable for adhesive products.
» Make sure that at least one hole is above the product surface.
* The hole diameter & should not exceed 10% of the pipe diameter D.
» Holes should be drilled on one side.
Figure 3-11. Recommended
hole size for pipe installations.
JA)
o
min. 6 in. (150 mm) o
o w
! i
)
° o)
I|
® &
o~ max. @: D/10. 3
I =
o) 2]
D
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Mounting in Bypass In tanks with turbulent conditions it is recommended to mount the transmitter
Pipes on a bridle pipe.

Figure 3-12. Bridle mounting is
recommended for tanks with
extremely turbulent surface
conditions.

BRIDLE_V2.EPS

l

Minimum 12 in. (300 mm)

!

In pipes with inlet pipe diameter @<2 in. (50 mm) the gap D between pipe and
antenna should be less than 0.2 in. (5 mm).

If the inlet pipe diameter @>2 in. (50 mm) the gap D between pipe and
antenna should be less than 0.04 in. (1 mm).

The distance A between the antenna and the nearest inlet pipe should be at
least 2 in. (50 mm).

Figure 3-13. Recommended
specifications for bridles with

pipe inlets. [T | [ 1T

@ (in./mm) D (in./mm)
<2/51 <0.2/5
>2/51 <0.04/1

A >2in./50 mm

QUIREMENTS.EPS

BRIDLE_RE

314



Reference Manual
00809-0100-4026, Rev DA
March 2006

Rosemount 5400 Series

ELECTRICAL
INSTALLATION

Cable/Conduit Entries

Grounding

Cable Selection

Hazardous Areas

External Circuit Breaker

The electronics housing has two entries with ¥2 - 14 NPT threads. Optional
M20x1.5 adapters are also available. The connections are made in
accordance with national, local and plant electrical codes.

Make sure that unused ports are properly sealed to prevent moisture or other
contamination from entering the terminal compartment of the electronics
housing. Install wiring with a drip loop. The bottom of the loop must be lower
than the cable/conduit entry.

NOTE!
Use the enclosed metal plug to seal any unused port.

The housing should always be grounded in accordance with national and
local electrical codes. Failure to do so may impair the protection provided by
the equipment. The most effective grounding method is direct connection to
earth ground with minimal impedance. There are two grounding screw
connections provided. One is inside the Terminal compartment of the housing
and the other is located on one of the cooling fins below the housing. The
internal ground screw is identified by a ground symbol: @

NOTE!
Grounding the transmitter via threaded conduit connection may not provide
sufficient ground.

NOTE!
After installation and commissioning make sure that no ground currents exist
due to high ground potential differences in the installation.

Use shielded twisted pair wiring for the Rosemount 5400 Series. The cables
must be suitable for the supply voltage and approved for use in hazardous
areas, where applicable. For instance, in the U.S., explosion-proof conduits
must be used in the vicinity of the vessel. For the ATEX flameproof approval
version of the Rosemount 5400 Series, suitable conduits with sealing device
or flameproof (EEx d) cable glands must be used depending on local
requirements.

Use 18 AWG to 12 AWG wiring in order to minimize the voltage drop to the
transmitter.

When the Rosemount 5400 Series transmitter is installed in a hazardous
area, national and local regulations and specifications in applicable
certificates must be observed.

For complicance with Low Voltage Directive 73/23/EEG an external circuit
breaker should be installed.
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Power Requirements Terminals in the transmitter housing provide connections for signal wiring.

The 5400 transmitter operates with the following power supplies:

Approval Type Power Supply (VDC)

IS 16 - 30
Explosion-Proof/Flameproof 20-42.4
None 16-42.4
Maximum Loop The maximum current loop resistance can be obtained from the following

Resistance diagrams:

Figure 3-14. Intrinsically Safe

installation.
7]
o
w
o
]
Z
x
[
Z
A
<
(o]
-
x
' o U(v) £
40 50
Figure 3-15. Explosion-Proof/
i 1 NOTE
FlameprOOf installation. R(Q) This diagram is only valid if the HART load
resistance is at the + side and if the - side
1400 is grounded, otherwise the maximum load
resistance is limited to 435 Ohm.
4
w
o
X
4
la)
<
o
-
x
s U(V) 2
50 =
Figure 3-16. Non-hazardous
installation. R(Q) N
w
o)
7]
=z
x
'_
z
2!
o
Z
[a)
<
(o]
-
U)X
50 <§(

See Figure 3-18 for wiring information.
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Connecting the
Transmitter

Figure 3-17. Terminal
compartment and external
ground screw.

The Rosemount 5400 Series accepts power supplies ranging from 16 V dc to

42.4 V dc. It uses 4-20 mA power superimposed with a HART signal.

To connect the transmitter:

1. Make sure that the power supply is switched off.

2. Remove the terminal block cover.

3. Pull the cable through the cable gland/conduit. Install wiring with a drip
loop. The bottom of the loop must be lower than the cable/conduit entry.

4. Connect wires according to Figure 3-18 for non-intrinsically safe power

supplies and according to Figure 3-19 for intrinsically safe power

supplies.

5. Use the enclosed metal plug to seal any unused port.

6. Mount the cover and tighten the cable gland. Make sure that the cover is

fully engaged to meet explosion-proof requirements.
Note that adapters are required if M20 glands are used.

7. Tighten the Locking Screw @) (ATEX Flameproof and IECEx versions).

8. Switch on the power supply.

NOTE!

Use Teflon® tape or other sealant at the NPT threads in the Cable Entries.

RATED TO AT
LEAST 90 “C

(1) Cable entries.

@ Internal Ground screw.

(@ Terminals for signal and power supply.
@ Locking screw.

(B External Ground screw

GROUNDINGSCREW.EPS/JUNCTION_BOX.EPS
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Non-Intrinsically Safe With non-intrinsically safe power supply in non-hazardous installations or
Power Supply Explosion-proof/Flameproof installations, wire the transmitter as shown in
Figure 3-18.
NOTE!

Make sure that the power supply is off when connecting the transmitter.

Figure 3-18. Wiring for
non-intrinsically safe power

supply.
375 Field
Communicator 5400 Series Radar Transmitter
; : \z
|:| HART Modem lemg=
= b A
L I DEE
EAEE
DEE
— oe
RRM 5o o
AMS Suite AMBIENT TEWPS

REQUIRE WIRING
RATED TO AT
LEAST 90 °C

Load resistance

—()

The 375 Field Communicator and the HART Modem require a minimum load
resistance of 250 Ohms within the loop in order to function properly. For
maximum loop resistance see Figure 3-16.

Power
supply

WIRING_NON_IS.EPS

NOTE!

For Explosion-proof/Flameproof installations make sure that the transmitter is
grounded to the I.S. ground terminal inside the terminal compartment in
accordance with national and local electrical codes.
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Intrinsically Safe Power
Supply

Figure 3-19. Wiring diagram for
intrinsically safe power supply.

When your power supply is intrinsically safe, wire the transmitter as shown in
Figure 3-19.

NOTE!
Make sure that the instruments in the loop are installed in accordance with
intrinsically safe field wiring practices.

375 Field ) )
Communicator 5400 Series Radar Transmitter

u]
L HART Modem

1

1 —

RRM

AMS Suite AMBIENT TENPS

supply

Power +

REQUIRE WIRING

RATED TO AT
LEAST 90 °C

Load resistance

250

Approved IS Barrier T~ -7

WIRING_IS.EPS

The 375 Field Communicator and the HART Modem require a minimum load
resistance within the loop of 250 Q in order to function properly. For maximum
load resistance see Figure 3-14.

IS parameters
Ui=30 V.
[i=130 mA.
Pi=1.0 W.
Ci=7.26 nF.
Li=0.
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Section 4

SAFETY MESSAGES

ROSEMOUNT

Configuration/Start-Up

Safety Messages . ... page 4-1
OVEeIVIBW . o e e page 4-2
Basic Configuration ............ ... ... . . . page 4-3
Echo Tuning ...... ... i page 4-9
Configuration Using Rosemount Radar Master ........ page 4-12
Configuration Using a 375 Field Communicator ....... page 4-21
AMS Suite ... .. page 4-24

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A.). Refer to
the safety messages listed at the beginning of each section before performing
an operation preceded by this symbol.

Explosions could result in death or serious injury:

Verify that the operating environment of the gauge is consistent with the appropriate
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make
sure the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit
is alive.

All connection head covers must be fully engaged to meet explosion-proof
requirements.

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

EMERSON.

Wwww.rosemount.com

Process Management
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OVERVIEW

Basic Configuration

Echo Tuning

Advanced Configuration

Configuration Tools

4-2

Configuration of a Rosemount 5400 transmitter is normally a simple and
straight-forward task. If the transmitter is pre-configured at factory according
to the ordering specifications in the Configuration Data Sheet, no further Basic
Configuration is required unless tank conditions have changed. The 5400
Series supports a set of advanced configuration options as well, which can be
used to handle special tank conditions and applications.

The Basic Configuration includes parameters for a standard configuration
which is sufficient in most cases. The Basic Configuration comprises the
following items:

* Measurement Units

e Tank Configuration
- Tank Geometry
- Environment
- Volume

* Analog Output

Echo Tuning is used to handle special situations when there are objects in the
tank which cause disturbing echoes that are stronger than the surface echo.
The following tools are available to handle such situations:

» Amplitude Threshold Curve (ATC)
» False Echo registration

For some applications further configuration is needed in addition to the Basic
Configuration. This may be due to the properties of the product or the shape
of the tank. Disturbing objects and turbulent conditions in the tank may also
require that advanced measures are taken. See Appendix C: Advanced
Configuration for more information.

There are several tools available for basic configuration of a 5400 transmitter:

* Rosemount Radar Master (RRM). Note that RRM is required for
advanced configuration features.
See “Configuration Using Rosemount Radar Master” on page 4-12 for
information on how to use RRM for configuration of the 5400 Series.

* Rosemount 275/375 Handheld Communicator.
See “Configuration Using a 375 Field Communicator” on page 4-21 for
the Field Communicator Menu Tree.

» AMS Suite software.
RRM is a user-friendly, Windows® based software package including

waveform plots, off-line/on-line configuration Wizard, logging, and extensive
on-line help.

To communicate with the transmitter using RRM, a HART® modem (part
number 03300-7004-0001) is required.
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BASIC CONFIGURATION

Measurement Units

Tank Geometry

Figure 4-1. Tank Geometry.

This chapter describes the basic parameters that need to be configured for a

Rosemount 5400 transmitter. If the transmitter is pre-configured at factory

according to the ordering specifications in the Configuration Data Sheet, no
further basic configuration is needed unless conditions have changed since

the ordering date.

At the end of this section different configuration tools are described.

Measurement units can be specified for presentation of Level, Level Rate,

Volume and Temperature values.

Tank Height

The Tank Height is the distance between the Upper Reference Point at the

underside of the transmitter flange or the threaded adapter, and the Lower
Reference Point close to or at the bottom of the tank (see Figure 4-2 for

further information on Upper Reference Points for various tank connections).
The transmitter measures the distance to the product surface and subtracts
this value from the Tank Height to determine the product level.

Uppe

Product Level

Lowe
(Leve

r Reference Point

1 Dead Zone

Tank Height (R)

r Reference Point
1=0)

TANKGEOMETRY_STANDARD.EPS
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Figure 4-2. Upper Reference
Point

Rod antenna with
threaded tank Rod antenna

connection i
with flange Cone antenna

Process Seal
antenna

UPPER REFERENCE POINT | |

5400 _UPPERREFERENCE_M.EPS

|

Tank Type and Tank Bottom Type

The 5400 transmitter is optimized according to the Tank Type and Tank
Bottom Type configuration by automatically setting some parameters to
predefined default values.

Select Tank Bottom Type Flat Inclined if the bottom inclination is between 10
and 30 degrees. If the inclination is less than 10 degrees but there are
disturbing objects on the tank floor (like heating coils) within the radar beam,
this selection should also be used. If inclination is greater than 30 degrees
use Tank Bottom Type Cone.

Table 4-1. Tank Type and Tank Bottom Type

Tank Type Tank Bottom Type

Vertical Cylinder Flat, Dome, Cone, Flat inclined
Horizontal Cylinder Not used

Spherical Not used

Cubical Flat, Dome, Cone, Flat inclined

Figure 4-3. The transmitter can

be optimized for different tank
types and bottom shapes. E @

Flat Dome Flat inclined Cone Spherical

TANKTYPE.EPS
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Process Conditions

Pipe Diameter

When the transmitter is mounted in a still pipe the inner diameter of the pipe
must be specified. The Pipe Diameter is used to compensate for the lower
microwave propagation speed inside the pipe. An incorrect value will give a
scale factor error. If locally supplied still pipes are used, make sure the inner
diameter is noted before the pipe is installed.

Dead Zone

The measurement accuracy is reduced within the Dead Zone region close to
the antenna. It is recommended that the Upper Range Value (20 mA) is set
outside the Dead Zone.

Describe the conditions in your tank according to the Tank Environment
parameters for Process Conditions listed below. For best performance,
choose only if applicable and not more than two options.

Rapid Level Changes

Optimize the transmitter for measurement conditions where the level changes
quickly due to filling and emptying of the tank. As a default standard a 5400
transmitter is able to track level changes of up to 1.5 inch/s (40 mm/s). When
the Rapid Level Changes check box is marked, the transmitter can track level
changes of up to 8 inch/s (200 mm/s).

Turbulent Surface

This parameter should be used if the tank shows a turbulent surface. The
reason for the turbulence might be splash loading, agitators, mixers, or boiling
product. Normally the waves in a tank are quite small and cause local rapid
level changes. By setting this parameter the performance of the transmitter
will be improved when there are small and quickly changing amplitudes and
levels.

Foam

Setting this parameter optimizes the gauge for conditions with weak and
varying surface echo amplitudes such as foam. When the foam is light and
airy the actual product level is measured. For heavy and dense foam the
transmitter measures the level of the upper surface of the foam.

Solid Products (Future)

Setting this parameter optimizes the transmitter for solid products, for
example concrete or grains, which are not transparent for radar signals. For
instance, this parameter can be used when the application is a silo with
product build-up.

Product Dielectric Range

The Dielectric Constant is related to the reflectivity of the product. By setting
this parameter measurement performance can be optimized. However, the
transmitter will still be able to perform well even if the actual Dielectric
Constant differs from the configured value.
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Volume

4-6

To configure the Rosemount 5400 transmitter for volume calculations you
have to choose the desired calculation method.

Volume calculation is performed by using a strapping table or a predefined
tank shape. You can choose one of the following standard tank shapes:

Sphere, Horizontal Cylinder, Vertical Cylinder, Horizontal Bullet or Vertical
Bullet.

The following parameters must be entered for a standard tank shape:
» Tank diameter.
» Tank height (not for spherical tanks).

» Volume Offset: use this parameter if you do not want zero volume and
zero level to match (for example if you want to include volume below
the zero level).

Strapping Table

The Strapping Table option should be used when the tank shape deviates
significantly from an ideal sphere or cylinder, or when high volume accuracy is
required.

The Strapping Table divides the tank into segments. Level values and
corresponding volumes are entered starting at the bottom of the tank. These
figures can typically be obtained from tank drawings or from a certificate
provided by the tank manufacturer. A maximum of 20 strapping points can be
entered. For each level value the corresponding total volume up to the
specified level is entered.

The volume value is interpolated if the product surface is between two level
values in the table.
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Analog Output For the analog output the Output Source (Primary Value), Range Values and
Alarm Mode are specified.

Figure 4-4. Standard Range
Value settings.

Dead Zone

20 mA Upper Range Value (URV)

Product Level - -+—

Range 0-100%

____________________ | _l.__* _ 4mA Lower Range Value (LRV)

Lower Reference Point
(Level=0) -

ANALOGOUT_SATNDARD.EPS

Output Source/Primary Variable

Specify the source to control the analog output. Typically the Primary Value is
configured to be Product Level.

Upper/Lower Range Value

Enter the range values that correspond to the analog output values 4 and 20
mA. It is recommended that the 20 mA point is set below the Dead Zone since
the measurement accuracy is reduced in this region. See “Specifications” on
page A-1 for information on the Dead Zone.

If a measured value goes beyond the measurement range, the transmitter
enters saturation mode (limit alarm is disabled) or alarm mode depending on
the current configuration.

Alarm Mode

Choose the desired Alarm mode to specify the analog output state when there
is a failure or a measurement error.

High: the output current is set to the High Alarm Limit.
Low: the output current is set to the Low Alarm Limit.

Freeze Current: the output current is set to the last valid value at the time
when the error occurs.

4-7



Reference Manual
00809-0100-4026, Rev DA

Rosemount 5400 Series March 2006

Default settings for alarm mode:
» Measurement errors: Output current=High.

» Measured value out of range: transmitter enters saturation mode (if
Limit Alarm is disabled).

Table 4-2. Analog Output:
Standard Alarm Values vs.

Saturation Values. Level 4-20 mA Saturation Values 4-20 mA Alarm Value
Low 3.9 mA 3.75 mA
High 20.8 mA 21.75 mA

Table 4-3. Analog Output:

NAMUR-Compliant Alarm
Values vs. Saturation Values 4-20 mA Saturation Values 4-20 mA Alarm Value

High 20.5 mA 22.5 mA
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ECHO TUNING When the Basic Configuration is performed the transmitter may need to be
tuned to handle disturbing objects in the tank. There are different methods
available for disturbance echo handling with the Rosemount 5400 Series
Transmitter:

» Amplitude Threshold Curve (ATC)
» False Echo registration

The Guided Setup in the configuration program Rosemount Radar Master
includes a Measure and Learn function which automatically registers false
echoes and creates an ATC (see “Guided Setup” on page 4-15).

Amplitude Threshold Setting up an Amplitude Threshold Curve makes tracking of the product

Curve surface more robust in the presence of noise and weak disturbing echoes.
The ATC is normally used for filtering out disturbances with an amplitude that
is smaller than the amplitude of the product surface echo.

Figure 4-5. Weak disturbing
echoes can be filtered out by
creating an amplitude threshold.

2000
1800
1600 P1 Surface
> 1400
0851200 Measurement signal
51000
2 800
Z .
600| Amplitude Threshold Curve P2 Unknown 0
w
400 \ o
200 N
o)
0 @
0 1.0 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0 5
Distance, m §

The Amplitude Threshold Curve function is available in the Rosemount Radar
Master (RRM) program.
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Registration of False The False Echo function is used to improve the performance of the gauge
Echoes when the surface is close to a horizontal surface of a stationary object in the

tank. The object causes an echo when it is above the surface. When the
echoes from the surface and the object are close to each other, they might
interfere and cause a decrease in performance.

Figure 4-6. The Rosemount
5400 can handle disturbing
radar echoes.

Disturbing
objects

False echo

Surface echo

FALSE_ECHOES.EPS

The False Echo function allows you to register disturbing echoes caused by
objects in the tank. When the surface is passing by a disturbing object, the
gauge can measure with higher reliability, when the position of the object is
registered. This makes it possible to detect a product surface close to a
disturbance echo even if the surface echo is weaker than the disturbing echo.
See the following recommendations before you register new interfering
echoes:

» Make sure that a correct amplitude threshold curve is set before you
register any disturbance echoes (see “Amplitude Threshold Curve” on
page 4-9).

» Compare the list of interfering echoes with the tank drawing or by visual
inspection of the tank. Note if there are objects like beams, heating
coils, agitators, etc. which correspond to the found echoes. Only
register echoes above the Amplitude Threshold Curve which can be
clearly identified as objects in the tank, keeping the number of
registered echoes to a minimum.

» Make sure the level is stable before you register a disturbance echo. A
fluctuating level may indicate a temporary disturbance which is not due
to an interfering object.

» Do not register False Echoes located below the product surface. It is
recommended that registration is done when the tank is empty.
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Figure 4-7. Disturbing echoes
can be filtered out by registration
as False Echoes.
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The False Echo Registration function is available in the Rosemount Radar
Master (RRM) program, in the AMS Suite as well as for the 275/375 Handheld
Communicator.
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CONFIGURATION USING
ROSEMOUNT RADAR
MASTER

System Requirements

Help In RRM

4-12

The Rosemount Radar Master (RRM) is a user-friendly software tool that
allows you to configure the Rosemount 5400 transmitter. You can choose
either of the following two methods to configure a Rosemount 5400
transmitter with RRM:

» Guided Setup Start if you are unfamiliar with the 5400 transmitter (see
page 4-15).

» Use the Setup function if you are already familiar with the configuration
process or if you just want to change the current settings (see
page 4-20).

Hardware

Processor (minimum/recommended): Pentium 200 MHz/1 GHz
Memory (minimum/recommended): 64/128 MB RAM

COM Port: 1 serial COM port

Graphical Card (minimum/recommended):
screen resolution 800 x 600/1024 x 768.

Hard drive space: 100 MB

Software

Operating Systems supported:

Windows 98 - service pack 3 and above
Windows NT 4 - service pack 6 and above
Windows 2000

Windows XP

Help is accessed by selecting the Contents option from the Help menu. Help
is also available via a Help button in most windows.
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Installing the RRM
software

To install the Rosemount Radar Master:

1. Insert the installation CD into your CD-ROM drive.

2. If the installation program is not automatically started, choose Run from
the Windows Start bar.

Microsoft Word
Microsoft Excel

All Programs D

CI—

| Opens a program, folder, document, or Web site,

fdstat S @@ ”

L

#( Log OFF

@| Shut Dowr

3. Type D:\RRM\Setup.exe where D is the CD-ROM drive.

4. Follow the instructions on the screen.
5. For Windows 2000/XP set COM Port Buffers to 1, see page 4-14.

To start the RRM:

1. From the Start menu click Programs>Saab Rosemount>Rosemount
Radar Master or click the RRM icon in the Windows workspace. Now
RRM searches for the transmitter.

RRM/START_BAR_RUN.TIF

2. When the transmitter is found press Yes to connect. If communication

does not work check that the correct COM port is connected on the

computer and that the COM port is properly configured, see “Specifying
the COM Port” on page 4-14.

3. In the RRM Status Bar verify that RRM communicates with the

transmitter.

Taools

ﬂ Online

4 LT_1_5400

Information Window

Active Device changed to LT_1_5400
Device Connected LT_1_5400

|Jzer

Device Status: OF,

RRM communicates
with the transmitter

Taools

£} Oifiine

4 LT_1_5400

Information Window

Active Device changed to LT_1_5400
Device Connected LT_1_5400

|Jzer

Device Status: OF,

No communication
with the transmitter

RRM/STATUSBAR.TIF/STATUSBAR_OFFLINE.TIF
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Specifying the COM Port If communication is not established open the Communication Preferences
window and check that the correct COM Port is selected:

1. From the View menu select Communication Preferences in RRM.
Figure 4-8. Communication

Settings.
g = B Communication Settings x|
Modbus I HART
[¥ Enable HART Communication Diefault |
— Part Setting
Fart Modem
COM1 | |Rs-232 |

3
—Advanced ;
Baudrate Handshake %
{1200 4| |RTS/CTS 4| F
Stop Bitz Fesponze Timeout %
1 =l J1000 me S
Parity Retriez E
[Oad =l |3 S)
Preambles %
|5 =
=
(e}
Q
QK | Cancel | Apply | Help | E
o

2. Make sure that HART communication is enabled.

3. Check which COM port that the modem is connected to.

4. Choose the COM Port option that matches the actual COM Port on the
PC that the transmitter is connected to.

To set the COM port buffers

For Windows 2000/XP the COM port Receive Buffer and Transmit Buffer
need to be set to 1. To set the COM port buffers do the following:

1. In the MS Windows Control Panel open the System option.
Choose the Hardware tab and click the Device Manager button.
Expand the Ports node in the tree view.

Click the right mouse button on the selected COM port and choose
Properties.

Select the Port Settings tab and click the Advanced button.
Drag the Receive Buffer and Transmit Buffer slides to 1.
Click the OK button.

Reboot the computer.

P wnN

© N o O

Specifying Measurement  Measurement units for data presentation in RRM can be specified when the
Units RRM program is installed. Units can also be changed as follows:

1. From the View menu, choose the Application Preferences option.
2. Select the Measurement Units tab.

3. Choose the desired units for Length, Level Rate, Volume and
Temperature.
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Guided Setup

Run Wizard

WIZARD_ICON.TIF/RRM/WIZARD_ST1.TIF

RRM/WIZARD_ST2.TIF

WIZARD_GENERAL.TIF

The following description shows how to use the RRM Guided Setup. The
corresponding HART commands (275/375 Handheld Communicator Fast Key
Sequence) are also shown. The Guided Setup is specially useful if you are
unfamiliar with the 5400 transmitter.

Guided Setup - [LT-01] x|

D Fun Wizard for quidsd setup

@ Configure Thissholds and False Echo Areas
3 g_ﬂl Restart the Device

@ _I View live values from devics

® ﬁl Make a complete backup of the Device

Grep 1
I the Wizard dialog you wil be guided through a few basic steps in arder to
laet the device up and running, More canfiguration parameters are available
in the individual Setup didlogs [see Setup menul.

[ Do not show this dislog again Close

a
) | evomple "Device 123')

PLANT A — | evample "Calibrated by John')

P Crca | b

1. Start the RRM program. RRM automatically

presents a list of available transmitters. Select
the desired transmitter. Now the transmitter is
connected and the Guided Setup window
appears automatically.

. Inthe Guided Setup window , click the Run

Wizard... button and follow the instructions.

Now you will be guided through a short
transmitter installation procedure.

Note! The Guided Setup is an extended
installation guide that includes more than just
the configuration Wizard. It can be disabled by
deselecting the Show Introduction Dialog after
Connect check box in the Application Settings
window (menu option View>Application
Preferences).

. The first window in the configuration wizard

presents general information such as device
type (5400), device model, antenna type,
serial number and communication protocol.
Check that the information complies with the
ordering information.

. This window lets you enter Tag, Tag

Descriptor, Message and Date. This
information is not required for the operation of
the transmitter and can be left out if desired.
HART command: [1,4,1].
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5. Choose the Tank Type which corresponds to

the actual tank. If none of the available
options matches the actual tank choose
Unknown.

HART command: [1,3,4,1].

Tank Bottom Type is important for the
measurement performance close to the tank
bottom.

HART command: [1,3,4,2].

Tank Height is the distance from the Upper
Reference Point to the tank bottom (see “Tank
Geometry” on page 4-3). Make sure that this
number is as accurate as possible.

HART command: [1,3,4,3].

Select the Enable Still Pipe/Bridle
Measurement check box and enter the Pipe
Inner Diameter if the transmitter is mounted
in a Still Pipe or Bridle.

HART command: [1,3,4,4]/[1,3,4,5].

See “Tank Geometry” on page 4-3 for more
information.

. In the Process Conditions box select the

check boxes that correspond to the conditions
in your tank. You should select as few options
as possible and not more than two. See
“Process Conditions” on page 4-5 for more
information.

Choose the Product Dielectric Range that
corresponds to the current product. If you are
uncertain about the correct range value for
this parameter, or if the contents in the tank is
changing on a regular basis, choose
Unknown.

HART command: [1,3,4,6].
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WIZARD_VOLUME.TIF

WIZARD_ANALOGOUT.TIF

WIZARD_FINISH.TIF
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7. If volume calculation is desired choose a

pre-defined calculation method that is based
on a tank shape that corresponds to the
actual tank. Choose None if volume
calculation is not desired.

The Strapping Table option is used if the
actual tank does not match any of the
available options for pre-defined tanks or if
higher calculation accuracy is desired.

HART command: [1,3,4,7].

See “Volume” on page 4-6 for more
information.

. Typically, the Primary Variable (PV) is

configured to be Product Level or Volume.
Specify the analog output range by setting the
Lower Range Value (4 mA) and the Upper
Range Value (20 mA) to the desired values.
The Alarm Mode specifies the output state
when a measurement error occurs.

HART command: [1,3,5].
See “Analog Output” on page 4-7 for more

information on Analog Output configuration
and Alarm Mode settings.

. This is the last window in the Configuration

Wizard concluding the basic configuration.
The current configuration can be changed at
any time by using the Setup windows
(General, Tank, Output etc., see “Using the
Setup Functions” on page 4-20).

The Setup windows contain further options
not available in the configuration wizard.
Click the Finish button and continue with the
next step in the Guided Setup.
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Step 2 in the Guided Setup allows you to
automatically configure an Amplitude
Threshold Curve and to register false echoes
by running the Measure and Learn function.
See “Echo Tuning” on page 4-9 for more
information on amplitude thresholds and false
echoes.

Click button 2 to start the Measure and Learn
function.

(If there is no need for Echo Tuning, or if you
want to do this at a later stage, go on to step 3
in the Guided Setup).

Click the Yes button if you want to run the
Measure and Learn function. If you click No
you can run this function at a later stage by
using the Spectrum Analyzer in RRM.

Make sure that there is no filling or emptying
going on when the Measure and Learn
function is used.

The Measure and Learn function
automatically creates an Amplitude Threshold
Curve (ATC) and suggests False Echo Areas,
see also “Echo Tuning” on page 4-9.

(By clicking the Advanced button you can
choose one of the options or both by selecting
the corresponding check box).

Verify the Tank Precondition settings. Check
that the Distance to Surface value is correct (if
not it may be due to a disturbing object in the
tank). Choose Empty Tank if the tank is empty.

The automatically created Amplitude
Threshold Curve (ATC) and False Echo Areas
are shown in the Spectrum Plot. False Echo
Areas are presented as shaded areas, and
represent tank levels where RRM has found
interfering echoes to be blocked out. False
Echo Areas can be moved or removed before
storing to the transmitter database. Make sure
that each False Echo Area can be identified
as an object in the tank that gives rise to a
disturbing echo. See “Echo Tuning” on

page 4-9 for more information.

Click the Store button to save the ATC and the
registered disturbance echoes.
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Using the Setup
Functions

Figure 4-9. Setup functions in
RRM.
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Use the Setup function if you are already familiar with the configuration
process for the 5400 transmitter or if you just want to change the current
settings:

. Start the RRM software.
. In the RRM workspace choose the

appropriate icon for configuration of
transmitter parameters:

Wizard: the Wizard is a tool that
guides you through the basic
configuration procedure of a 5400
transmitter.

General: configuration of general
settings such as measurement
units and communication
parameters. This window also lets
you configure which LCD variables
to be displayed.

Tank: configuration of Tank
Geometry, Tank Environment and
Volume.

Output: configuration of Analog
Output.

Echo Tuning: disturbance echo
handling.

Advanced: advanced
configuration.
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CONFIGURATION USING
A 375 FIELD
COMMUNICATOR

Figure 4-10. The 375 Field
Communicator.

The 5400 transmitter can be configured by using a 375 Field Communicator.
A 275 HART Communicator may also be used. All HART commands are
available for the 375 Field Communicator as well as for the 275 HART
Communicator.

The menu tree with the various configuration parameters is shown in Figure
4-11 on page 4-22. Section “Basic Configuration” on page 4-3 presents a
description of the basic configuration parameters. See also sections “Echo
Tuning” on page 4-9 and “Advanced Configuration” on page C-1 for
information on disturbance echo handling and advanced configuration.

For information on all the capabilities, refer to the 375 Field Communicator
Product Manual (document 00809-0100-4276).

Navigation Keys
Tab Key

Alphanumeric Keys
Enter Key

Function Key

Backlight adjustment key

375_FIELDCOM.EPS

1. Check that the desired Measurement Units are selected.

2. Start the Guided Setup. HART command: [1,3,3]. This is a guided
installation procedure which lets you configure Tank Geometry, Process
Conditions, Primary Variable, Upper/Lower Range Values and Alarm
Mode.

3. Check the Application Complexity. HART command: [1,3,1]. If this value
is too high the configuration should be fine tuned by using the
Rosemount Radar Master configuration program.

4. If desired configure for Volume calculations. HART command: [1,3,4,6].

5. Echo Tuning. HART command: [1,4,4]. This function lets you create an
Amplitude Threshold Curve (ATC) and register false echoes.

6. Restart the transmitter. HART command: [1,2,5].
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Figure 4-11. HART Menu Tree

1 Variable mapping ——_>| 1 Mapping ———————I>| - Level
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5TCL
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Table 4-4. HART Fast Key Sequences

Function HART Fast Key

Alarm Mode 1,353
Antenna Type 1,451
Device Information 1,4,1
LCD Language 1,4,2,2
LCD Variables 1,421
Length Unit 1,3,2,1
Lower Range Value (LRV) (4 mA) 1,352
Pipe Diameter 1,3,4,5
Poll Address 1,4,31
Primary Variable 1,1,1,1
Product Dielectric Constant 1,3,4,6,2
Range Values (LRV/URV) 1,3,52
Tag 1,4,1,4
Tank Bottom Type 1,3,4,2
Tank Height 1,3,4,3
Tank Type 1,3,4,1
Temperature Unit 1,3,2,4
Hold Off Distance/Upper Null Zone 1,4,5,6
Upper Range Value (URV) (20 mA) 1,352
Volume Configuration 1,3,4,7
Volume Unit 1,323
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The 5400 Series transmitter can be configured by using the AMS Suite

1. Start the AMS software and connect to the
desired transmitter. The transmitter is shown
in the Device Connection View window.

2. To configure the 5400 transmitter:
1. Select the transmitter
2. Click the right mouse button
3. Choose the Configuration Properties
option.

As an alternative you may run the
Configuration Wizard for a quick start.

3. Configure the transmitter by selecting the
appropriate tab in the Configuration
Properties window. See “Basic Configuration”
on page 4-3 for more information.

Basic: configuration of measurement units,
Variable mapping (PV etc.), Tag, Tag
Descriptor, Message and Date.

Geometry: Tank type, tank height and other
tank related settings.

Volume: volume calculation method can be
chosen in this window. Choose None if
volume calculation is not desired.
Environment: process condition settings and
dielectric constant range that corresponds to
the current product.

Analog Output: range values and alarm
mode settings.
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ED?EIS:MCE :| 2. Choose the Echo Tuning option.
alibrate .
N p——— 3. Select the Create ATC option to create an
[~ —— Add False Echo Amplitude Threshold Curve.
0] i Remaove False Echo
= Unassign Set Threshald
% Rename
5 Audit Trail
I Record Manual Event
8 Drawings | Motes...
gl Help. ..
< Clear OFfline Configuration
g Compare Configurations. ..
< Configuration Properties. ..

List of found

echoes

AMS/AMS_ECHOES.TIF

Anpitude:

[ v
%
[
[0
73

—

History Curent. Dffne

e el Cowd | o | e

e ) o]
ﬂ Level [ e Rvis = 1 An 2000 mA
Distance [ En svie [oiance =1 %inge E9ET
ev 000 m/s i [CevelRate -]
v Level Pt T+ vy [ 200 n
2 [Signalst. -] [ o
e Sialsy ‘ PV LRV 0,000 m
e
we [ B8 deot
A
AN oampingvae [ 20+
SV
HART
’ DeviceModel  [5a0T = Ell Poll add T
Seilto | — Tag ROSEMOUNT
Messsg [ — 5400 RadsrLovel Traniter
Descier [
Butnoe [T = Help

AMS/03_AMS_PROCESS_VAR.TIF

. Choose the Echo Tuning option and select

Add False Echo to register the desired false
echoes.

A list of disturbing echoes can be viewed by
opening the Configuration
Properties/Echoes window. Before adding a
false echo check that the found echo
corresponds to a disturbing object in the tank.

. When Echo Tuning is finished restart the

transmitter by choosing the
Tools/Service>Restart option.

. Confirm the configuration by viewing

measured values:

1. Right-click the transmitter icon.

2. Choose the Process Variables menu
option.

3. In the Process Variables window verify that
the measured values are valid.
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Section 5

SAFETY MESSAGES

ROSEMOUNT

Operation

Safety Messages . ... page 5-1
Viewing MeasurementData ........................ page 5-2
LEDError Messages . ..., page 5-7

Procedures and instructions in this manual may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (4). Refer to
the safety messages listed at the beginning of each section before performing
an operation preceded by this symbol.

Failure to follow these installation guidelines could result in death or serious
injury.
« Make sure only qualified personnel perform the installation.

« Use the equipment only as specified in this manual. Failure to do so may
impair the protection provided by the equipment.

Explosions could result in death or serious injury.

« Verify that the operating environment of the transmitter is consistent with the
appropriate hazardous locations certifications.

« Before connecting a HART®-based communicator in an explosive atmosphere,
make sure the instruments in the loop are installed in accordance with
intrinsically safe or non-incendive field wiring practices.

Electrical shock could cause death or serious injury.

* Use extreme caution when making contact with the leads and terminals.

AWARNING

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution
of components etc., may also jeopardize safety and is under no circumstances allowed.

EMERSON.

Wwww.rosemount.com

Process Management
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VIEWING
MEASUREMENT DATA

Using the Display Panel

Figure 5-1. The 5400 Display
Panel.

5-2

The Rosemount 5400 transmitter uses an optional Display Panel for
presentation of measurement data. When the transmitter is switched on the
Display Panel presents information such as transmitter model, measurement
frequency, software version, communication type (HART, FF), serial number,
HART identification tag, setting of write protection switch and Analog Output
settings.

When the transmitter is up and running the Display Panel presents Level,
Signal Amplitude, Volume and other measurement data depending on the
Display Panel configuration (see “Specifying Display Panel Variables” on
page 5-3).

The display has two rows, the upper row shows the measured value and the
lower row shows the parameter name and measurement unit. The display
toggles between the different variables every 2 seconds. Variables to be
presented are configurable by using a 275/375 Handheld Communicator or by
using the Rosemount Radar Master software.

Measured value

Measured
parameter
Measurement unit.

Blinking symbol Q

indicates that system w

is running normally g

o

S
NOTE!

A malfunctioning display panel may only be replaced by service personnel at
Rosemount Service Department. A display must not be replaced when the
transmitter is in operation.
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Specifying Display Panel
Variables

Figure 5-2. RRM lets you specify
variables for the 5400 Display
Panel.

It is possible to specify the variables to be presented on the Display Panel

(LCD).

Using a Field Communicator

For a 275/375 Handheld Communicator the LCD settings are available with

HART command [1,4,2].

Using Rosemount Radar Master (RRM)

The LCD tab in the General window lets you specify which variables to view

on the Display Panel screen:

1. Choose the General option from the Setup menu, or
click the General icon in the Device Configuration window.

£~ Rosemount Radar Master - [LT-{

Device View Setup Took Service
[ A
Device Explorer x]

[73] Device List

148, LT-01 [ 5400 0D9

Device Config Device Config

Setup

General

2. Select the LCD tab.

T- General - [LT-01]

Communication Device Tag

LCD Status

IStatus oK

Lcd Parameters Language

Level English |
[ Distance [Ullage]

[ Level Rate

[[1 Signal Strength

WVolume

[ Intemal Temp

[ A0ut Current

Percent of Range

=10l x|

Read | Stare | Cloze |

Help

WORKSPACESETUP_GENERAL.TIF.TIF

RRM/RRM_GENERAL_LCD_TOGGLE.TIF

3. Select the variables you want to appear on the Display Panel. The LCD

will alternate between the selected items.

4. Click the Store button to save the LCD settings in the transmitter

database.
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Using AMS

The LCD tab in the Configuration Properties window lets you specify which
variables to view on the Display Panel screen:

1. To configure the 5400 transmitter:
1. In the Device Connection View window click the right mouse button on
the transmitter icon.
2. Choose the Configuration Properties option.

2. Select the LCD tab and select the desired LCD parameters.
3. Click the OK button to save the configuration and close the window.

Figure 5-3. The LCD tab in the

AMS configuaration window lets
you configure parameters to be
presented on the Display Panel.

' Configuration Properties of AMS Tag: Test device 12032003 (5400) - |EI|1|

Basic Setup | Geometry I WVolume I Enwironment I Analog Dutput | Echoes I Advanced | Device Info I

LCD Language English hd
LCD parameters P ters on LCD LCD Urit
¥ Level Length unit IAuto 'I E
[ Distance Welocity unit IAuto 'I ﬂ
[T Level Fiate ol urit IAuto 'I E
w
[T Signal Strength Temp unit IAuto 'I %
[T Wolume gl
[T Intermal Temp 9}
z
[~ ADut Curert 8
A0t % |
I ut #range 0
=
<l:l
~
; i = I vl o
History Current  Offline ]S I Cancel Apply Help g
<
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Viewing Measurement
Data in RRM

Figure 5-4. Presentation of
measurement data in RRM.

Figure 5-5. Presentation of
Analog Output value in RRM.

7 Devi

l Analog Dut]

Distance

2273 mm

Level Rate

0,000 mdh

Signal Strength

1200 mv

Wolume

55,040 m3

Internal Temperature
3BE C

Level

5721 mm

ce Display - [LT-01]

BEE

Cloze

Help

7 Device Display - [LT-01]

Analog Out 1
Level
Upper Range Yalue A
8000 mm
Current A0ut 1
71.51% 1544 md

Lower Range Yalue A

0 mm

BEE

Cloze

Help

To view measurement data such as Level, Signal Strength, etc. in Rosemount
Radar Master choose the Tools>Device Display option and select the Level
tab:

RRM/DEVICEDISPLAY_LEVEL.TIF

To view Analog Output signal choose the Tools>Device Display option and
select the Analog Out tab:

DEVICEDISPLAY_ANALOGOUT.TIF
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Viewing Measurement
Data in AMS Suite

Figure 5-6. Presentation of
measurement data in AMS
Suite.

5-6

To view measurement data such as Level, Signal Strength, etc. in the AMS
Suite do the following:

1. Select the transmitter in the Device Connection View window.
2. Click the right mouse button and choose the Process Variables option.

Status...
Scan Device

rocess Yariables... —

Tools{Service
Calibrate
Echo Tuning

Feplace
Umassian
Rename

Process Yariables of AMS Tag: Test device 12032003 (5400)

i~ Transmitter Y aiahl

Dynamic Yariables Mapping

03_AMS_PROCESS_VAR.TIF

AMS_CONFIG.TIF

_lojx

Analog Dutput

m A0 4,000 ma

n Level 3572 m P l
Distarce [ &% S | Hmae EIEET %
Level Fiats 0000 /s Tis evelFate - ? YW T
Signal Shiength [ = Wis [Signalst. =]
ignal 5tr. -
Py LAY 0000 m
Wolume MNaM Cum i
Interel Temperatue [~ 238 deot
;ﬁgi Damping Yalue 70 s
~ Devi HaRT
Device Model  [54m - Pol ddr ]
see [T ez ROSEMOUNT
Messans 54NN Riadlsr Lswel Transmittsr
Desseriptor
Burst made o - Hep |
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LED ERROR MESSAGES For Rosemount 5400 transmitters without display a flashing Light Emitting
Diode (LED) is used for presentation of error messages.

Figure 5-7. Rosemount 5400
transmitters without display use
a LED for presentation of error
messages.

Flashing LED

LED_ERRORMESSAGES.EPS

In normal operation the LED flashes once every other second. When an error
occurs, the LED flashes a sequence that corresponds to the Code number
followed by a five second pause. This sequence is continuously repeated.

The following errors can be displayed:

Table 5-1. LED error codes.

Code | Error

0 Ram Failure

1 FPROM

2 HREG

4 Microwave Module
5 Display

6 Modem

7 Analog Out

8 Internal Temperature
1 Hardware

12 Measurement

14 Configuration

15 Software

Example

Modem error (code 6) is displayed as the following flash sequence:

L | | | | | | J
0 5 10 15 20 25 30 35 Seconds

5-7
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Section 6

SAFETY MESSAGES

ROSEMOUNT

Service and Troubleshooting

Safety Messages . ... page 6-1
SBIVICE ot e page 6-2
Troubleshooting ......... ... ... ... . . . L. page 6-10

Procedures and instructions in this manual may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (4). Refer to
the safety messages listed at the beginning of each section before performing
an operation preceded by this symbol.

Failure to follow these installation guidelines could result in death or serious
injury.
« Make sure only qualified personnel perform the installation.

« Use the equipment only as specified in this manual. Failure to do so may
impair the protection provided by the equipment.

Explosions could result in death or serious injury.

« Verify that the operating environment of the transmitter is consistent with the
appropriate hazardous locations certifications.

« Before connecting a HART®-based communicator in an explosive atmosphere,
make sure the instruments in the loop are installed in accordance with
intrinsically safe or non-incendive field wiring practices.

« Any substitution of non-recognized parts may jeopardize safety. Repair, e.g.
substitution of components etc., may also jeopardize safety and is under no
circumstances allowed.

* Substitution of components may impair Intrinsic Safety.
Electrical shock could cause death or serious injury.
« Use extreme caution when making contact with the leads and terminals.

« To prevent ignition of flammable or combustible atmospheres, disconnect
power before servicing.

High voltage that may be present on leads could cause electrical shock:
« Avoid contact with leads and terminals.

« Make sure the main power to the 5400 transmitter is off and the lines to any
other external power source are disconnected or not powered while wiring the
gauge.

EMERSON.

Wwww.rosemount.com

Process Management
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SERVICE

Viewing Input and
Holding Registers

Figure 6-1. Holding and Input
Registers can be viewed in

RRM.

6-2

The functions mentioned in this section are all available in the Rosemount
Radar Master (RRM) configuration program.

Measured data is continuously stored in the Input Registers. By viewing the
contents of the Input Registers you can check that the transmitter works

properly.

The Holding Registers store various transmitter parameters such as
configuration data used to control the measurement performance.

By using the RRM program most Holding Registers can be edited by simply
typing a new value in the appropriate Value input field. Some Holding
Registers can be edited in a separate window. In this case you can change
individual data bits.

In order to be able to view the Input/Holding registers in RRM, the Service
Mode must be activated:

1. Choose the Enter Service Mode option from the Service menu.

2. Type the password (default password is “admin”). Now the View Input
and View Holding Registers options are available.

3. Choose the View Input/Holding Registers option from the Service menu.

4. Click the Read button. To change a Holding register value just type a
new value in the corresponding Value field. The new value is not stored
until the Store button is clicked.

T View Holding Registers EEE
Search Registers by Show Values in
+ Mames " Mumbers t« Dec " Hex
Start Register
Sip hd
Humber Identifier Yalues | Units A
1000| Sip-T ankHeight_R 8 m
1002| Sip-OffsetDist_G O0'm
1004 Sip-CalibrationDist 0'm
1006| Sip-BottomOffzetDist_C 0'm
1008| Sip-HoldOfDist 0.6 m
1010| Sip-TCL O0'm
1012] Sip-T ankE nvironment 0/ Bitfield
1014| Sip-Spare 0 na
101E| Sip-T ankPresentation 24832 Bitfield
1022| Sip-AmplitudeFiltF actor 0,25 na
1024| Sip-EchoTimeJut 30 s
1030| Sip-PipeDiameter 01 m
1032| Sip-ConFactor_ PP 0/ ppm
1034 | Sip-PropvelCornr_PPH 343,44 ppm
1036| Sip-JFILT_Delay 100 na L
1038| Sip-JFILT_Thresh 01'm =
1040] Sip-Damping/alue 25 Q
1042) Sip-ATC_Autokdiny alue 10 mi "4
1044] Sip-ATC_Autobd axalue 200 mi 9
1046| Sip-ATC_Autodddend 10 mi (@]
T048| SipATC_AutoF actar 1.1 na §
1050| Sip-Config 0 Bitfield w
1200| Sip-0FA_Chil 0/ Bitfield b ;I
Fiead Stare Cloze Help E
@
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Analog Output
Calibration

Logging Measurement
Data

Figure 6-2. The Log Registers
function can be used to verify
that the transmitter works

properly.

This function lets you calibrate the Analog Output by comparing the actual
output current with the nominal 4 mA and 20 mA currents. Calibration is done
at factory and normally the transmitter does not need to be recalibrated.

In RRM this function is available via Setup>Output.

By using the Log Device Registers function in the RRM software you can log
Input and Holding registers over time. It is possible to choose from different
pre-defined sets of registers. This function is useful for verifying that the

transmitter works properly.

To log device registers choose the Tools>Log Device Registers option to open

the Log Registers window:

Browse Select Register
[l Log Registers BEE
File name Select Registers Update Rate
[ [Standerd s
Scrolling Graph

T T T T T T T T T T T T
an 0 60 m a0 o0 100

Scale

¥ Auto Scale

Axis

Vs v
Start Log

Graph Type i Select Registers

Fiegister Sef;

@& Linear Scals

" Log Scale

" Custom

Click here to select ___
registers to be logged

Start Log

Registers to Log

Level [Standard Level]

Distance [Ullage] [Standard-Ullsge]

Signal Strength [Standard S ignalStrength]
Valums [Standardolume]

Current AQut 1 [A0utinfo-Curent]

Level Rate [StandardLevelRate]

Intemnal Temperature [StandarcHntemalT emperat.

SRS

LOGREGISTERS.TIF/LOGREGISTERSSELECTREGISTERS.TIF

ok Cancel Help

To start logging do the following:

1. Click the Browse button, select a directory to store the log file and type a

log file title.

2. Click the Select Register button and choose the desired range of

registers to be logged.

3. Enter the update rate. An update rate of 10 seconds means that the plot
will be updated every 10 seconds.

4. Click the Start Log button.
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Backing Up the
Transmitter
Configuration

Figure 6-3. It is recommended
that the transmitter configuration
is stored in a backup file.

Figure 6-4. The configuration
backup file can be viewed in a
word processor program.

6-4

Use this RRM option to make a backup copy of the configuration parameters
in the transmitter database. The backup file can be used to restore the
transmitter configuration. It can also be used for configuration of a transmitter
in a similar application. Parameters in the saved file can be uploaded directly
to the new device.

The backup function is available from the Device menu in RRM.

1. Choose the Backup Config to File option from the Device menu.

Select File to backup Device Configuration Ex

Save in: |_} Backup j £k B
Ie
My Recent
Documents
=1
5
My Computer E
- o
‘._‘] File name: |LTD1_54DD_DE2.bak j Save | Q
2 5
MyMNetwok  Saveastipe  [“bak -] Careel Eé
Flaces o
=
o
o

2. Browse to the desired directory.

3. Type a name of the backup file and click the Save button.
Now the transmitter configuration is stored. The backup file can be used
at a later stage to restore a configuration which has been accidentally
changed. The backup file can also be used to quickly configure
transmitters which are installed on similar tanks.To upload a backup
configuration choose the Upload Config to Device option from the
Device menu.
The backup file can be viewed as a text file in a word processing
program:

I LT01_5400.bak - Notepad

File Edit Format Wiew Help

swp-GainControl=0 -~
swp-Gainstartoffset=0. 000000

swp-5ignalio=4

Sip-TankHeight_R=8. 000000
sip-offsetpist_G=0.000000
sip-calibrationpist=0.000000
Sip-Bottomoffsetpist_C=0. 000000
Sip-Holdoffoist=0.600000

Sip-TCL=0. 000000

Sip-TankEnvironment=0

Ln 1, Col 1

RRM/BACKUP_VIEW.TIF
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Diagnostics

Figure 6-5. The Diagnostics
window in Rosemount Radar
Master.

Figure 6-6. Diagnostics window
in AMS Suite.

By using the RRM software the following information about the device can be

retrieved:

» device status, see “Device Status” on page 6-11.

» device errors, see “Errors” on page 6-12.

» device warnings, see “Warnings” on page 6-13.

* measurement status, see “Measurement Status” on page 6-14.
» volume status, see “Volume Calculation Status” on page 6-15.
» analog output status, see “Analog Output Status” on page 6-15.

To open the Diagnostics window in RRM choose the Diagnostics option from

the Tools menu.

T Diagnostics - [LT-01]

- % Device Statuz
O Device Emors
-y Device Wamnings
§ Measurement Statuz
Wolume Status

2 fnalog Out 1 Status

Device Status:
Device Emar:
Device Warming:

AQut 1 Status:

T Diagnostics - [LT_1_5400]

?. ? Diagnostics

Device Status

Device Emors

Device Warnings
g Measurement Status

Wolume Status
% Analog Out 1 Status

Diagnostics Summary:

Meazuring Status:
Calculation Status:

Device Status: 0 indication(z]
Device Ermar: 0 erar(z]
Device Warming: 0 warning(s]
Meazuring Status: 0 indication(z]
Calculation Status: 0 indication(z]
AQut 1 Status: 0 indication(z]

T=ES|

2 indication(z]
0 erar(z]

1 waming(s]
B indication(z]
0 indication(z]
1 indication(z]

Diagnostics Summary:

Click coresponding icon for detailed information

Cloze | Help |

RRM/DIAGNOSTICS.TIF, DIAGNOSTICS_WARNING.TIF

For a 275/375 Handheld Communicator the corresponding HART command
for the Diagnostics option is [1,2,1].

To view the Diagnostics window in AMS Suite click the right mouse button on
the desired transmitter and choose the Status option:

rocess Yariables...
Status...
Scan Device

Tools{Service 3
Calibrate 3
Echo Tuning 3

Feplace
Umassian
Rename

Audit Trail

Record Manual Event
Drawings | Motes...
Help. ..

B S2atin of AMS Tag: 101 [5400]

I

AMS/AMS_CONFIG.TIF, AMS_DIAGNOSTICS.TIF

[Corve Last Syretvirised: STOM-16 FRLTE
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Using the Spectrum Plot The Spectrum Plot in Rosemount Radar Master (RRM) lets you view the
measurement signal amplitude in the tank and includes the Echo Tuning
functionality (see “Echo Tuning” on page 4-9 for more information on false
echo handling).

Figure 6-7. The Spectrum Plot
function is a useful tool for signal
analysis.

WORKSPACE_TOOLSL.TIF

@ o e Online | 48 LT-01

Each radar echo is displayed as a peak in the signal plot. This is a useful tool
for obtaining a view of the tank conditions. The Spectrum Analyzer also lets
you register disturbing echoes and create an Amplitude Threshold Curve (see
Section 4: Echo Tuning for further information). When clicking the Spectrum
Plot icon the Spectrum Analyzer window appears with the View/Record tab
selected.

Figure 6-8. A spectrum plot in

View mode.
it Spectrum Analyzer - [LT-01]
Configuration Mods i View/Record Mode File Mode
+ Amplitude, v
1300
+om P1 Surtace {eBase
 Legend/Tpi
. egend/Dptions
¥ B Echo Curve
1000 ¥ @ Echo Pesks
00 m
¥ B ATP Curve =
800 ¥ B False Echo Areas a
700 ¥ B Hold Off Distance (UNZ] L
P3 Unknown ¥ B Zero Rsfersnce (Z)
500 ¥ B Max Meas Distance <
500 T O Previous Echo Curvels) 5
™ B Echo Pesk Trail <
400 ¥ O Echo Pesk Labeks |
300 Peaklno.. | & [ E
2m SI
- Surface search s
) =)
R 1 O O R O i Peak info K
Distance, mm 3 [8)
L
Fead )J .J n Note! Right Click plot for mors options! Close Help o
T Y
=
[ ) o
o

Record tank spectra

Play continuously updates the spectrum
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Surface Search

This function can be used to trigger the transmitter to search for the product
surface.

Peak Info
This function lists all echoes in the tank.
Record Tank Spectra

This function allows you to record tank spectra over time. This can be a useful
function if, for example, you want to study the tank signal when filling or
emptying the tank.

Play

When the Play button is clicked the tank spectrum is continuously updated
without being stored.

Configuration Mode Tab

This tab lets you use the Echo Tuning functions as described in section “Echo
Tuning” on page 4-9. Figure 6-9 illustrates the type information that can be
shown in the Spectrum Analyzer window in this mode.

Figure 6-9. The Spectrum Plot
presents all visible echoes in the

tank.
900
® False echo area ®
800
False echo area P1 Surface
> 700
E_ 600 Product surface
)
g 500
E— 400 Disturbing object P2 Unknown
Amplitude
< 300 Threshold Curve
200
e A AT / g
0 =
0 1.0 2.0 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0 @
'_
Distance (m) o
@]

To create an Amplitude Threshold Curve (ATC) and to register false echoes
click the Learn button in the Spectrum Analyzer/Configuration Mode window.

File Mode Tab

In the File Mode you can open saved shapshots/movies from file and present
in the spectrum plot. If it is a movie you can play the movie and the spectrum
plot is updated at desired update rate.

6-7
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Configuration Report This function in Rosemount Radar Master (RRM) shows what configuration
changes have been done to the transmitter compared to the factory
configuration. The report compares a specified backup file with the default
transmitter configuration.

Information on antenna type, software versions, software and hardware
configuration and unit code is presented.

Figure 6-10. The Configuration

Report WIndOW In Rosemount ﬁ Configuration Report - [LT-01] _|EI|1|
Radar MaSter' Farameters below has been changed compared to the default values for this device

Parameter WValue Lnit - |

Device Inf i

Pratocal HART

Address a

Device Tag LT-01

DeviceT ype 5400

“Wersion 005

Unit 1D 1

Factory Setup

Software Rev 4457729

Free Prop DAC O 1490

Date 1901-01-M

Meszage

Tag Descriptor

Tag

Sweep Setup

Delta Frequency 8|Hz

Tank Setup

Tank Height [R] B000) mm

Auto Conf Meas Func.sze Automatic Echo Tracking Settings True

Auto Conf Meas Func.Usze Automatic Echo Tracking Settings [4 True o

Echo Handling Setup I|:

Diigturb Digt 0 80| mm @

Disturb Dist 1 2000] mm Q

Analog Out Setup w

Upper Range Yalue CHO 0.5 g

Lower Range Yalue CHO 0,05 | o

4

Open | Frint | Cloze | Help | 8

Reset to Factory Settings  This function resets all or a specific part of the holding registers to factory
settings. It is recommended that a backup of the configuration is made before
the factory reset is done. Then the old transmitter configuration can be loaded
if necessary. To use this function in RRM choose Tools>Factory Settings.

Figure 6-11. The Reset to
Factory Settings window in
RRM.

17 Reset to Factory Settings - [LT-01] ﬂ

A WARNING - Select areas to reset
Al

Device Configuration Hazard

Wwhen rezetting to Factory Default
walues your configuration changes

will be lost and the device may L Factory Analog _DUt_

change behaviour. [CTHART Communication

Make sure spstems and people [JHART Tag, Message & Descriptor
relying on data from the device are [JLED

made aware of the changed [[] Foundation Figldbus

conditions due ta this action. []'waveform Generation

Failure to do g0 could result in death, [ Signal Pracessing and Geomety 1 LI
zerious injury and/or property
damage

QK | Cancel | Help |

RESETFACTORYSETTINGS.TIF

In AMS Suite: Tools/Service>Factory Settings.
275/375 Handheld Communicator: HART Command [1,2,8].
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Surface Search

Using the Simulation
Mode

Figure 6-12. The Simulation
Mode window in RRM.

Enter Service Mode in
RRM

Write Protecting a
Transmitter

The Surface Search command triggers a search for the product surface. Use

this function if, for example, the measured level has stuck on a disturbing

object in the tank (see “Using the Spectrum Plot” on page 6-6).

This function can be used to simulate measurements and alarms.

To open the Simulation Mode window in RRM choose Tools>Simulation

Mode:

Simulation Mode - [LT-01]

A WARNING

— Simulation Y alue
Distance [simulated]

Device Communication Hazard

Druring simulation the output from
the device will not be controlled by
the device measurement.

Make sure spstems and people
relying on data from the device are
made aware of the changed
conditions when entering/exiting
simulation mode.

Failure to do so could result in
death, serious injury and/or
property damage

| 0 mm

[~ Enable Measurement Alarm [simulated]

[~ Enable Device Failure Alarm [simulated]

Status: Live ¥alues. No Simulation.

— Wiew live/simulated value:

%@ | Prezz button to open Device Display

Cloze

Help

AMS Suite: Tools>Service>Simulation Mode.
275/375 Handheld Communicator: HART Command [1,2,2].

In Rosemount Radar Master (RRM) some useful service functions are
available for the 5400 Series transmitter. By setting RRM into the Service
Mode all the Service menu options in RRM are enabled. The default
password for enabling the Service Mode is “admin”. The password can be

SIMULATIONMODE.TIF

changed by selecting the Change Password option from the Service menu.

A 5400 Series transmitter can be protected from unintentional configuration
changes by a password protected function.

RRM: Tools>Lock/Unlock Configuration Area.

AMS Suite: Tools>Service>Lock/Unlock Device.

275/375 Handheld Communicator: HART Command [1,2,7].

If a 5400 Series transmitter is ordered with write protection enabled the
default password is 12345. It is recommended that this password is not
changed in order to facilitate service and maintenance of the transmitter.
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TROUBLESHOOTING

Troubleshooting

If there is a malfunction despite the absence of diagnostic messages, see

Table 6-1 for information on possible causes.

NOTE!

If the transmitter housing must be removed for service, make sure that the
Teflon sealing is carefully protected against dust and water.

Table 6-1. Troubleshooting
chart

Symptom
No level reading

Possible cause

* Power disconnected
« Data communication cables
disconnected

Action

» Check the power supply.
Check the cables for serial data
communication.

No HART communication.

« COM Port configuration does not match
the connected COM Port.

« Cables may be disconnected.

* Wrong HART address is used.

Hardware failure.

Check that correct COM Port is
selected in the HART server (see
“Specifying the COM Port” on

page 4-14).

Check the COM port buffer, “Specifying
the COM Port” on page 4-14.

Check wiring diagram.

Verify that the 250 Ohm resistor is in
the loop.

Check cables.

Make sure that correct HART short
address is used. Try address=0.
Check the COM Port Buffer setting, see
page 4-14.

Check Analog Output current value to
verify that transmitter hardware works.

Analog Out is set in Alarm.

Measurement Failure or Transmitter
Failure.

Open the Diagnostics window in RRM to
check active errors and alarms, see
“Diagnostics” on page 6-5. See also
“Analog Output Status” on page 6-15.

Incorrect level reading.

« Configuration error.
« Disturbing objects in the tank.
« See “Application Errors” on page 6-16.

* Check the Tank Height parameter;
RRM>Setup>Tank.

Check status information and
diagnostics information, see
“Diagnostics” on page 6-5.

Check that the transmitter has not
locked on an interfering object, see
“Using the Spectrum Plot” on page 6-6.

Integral display does not work.

Check the display configuration in
Rosemount Radar Master (open menu
Setup>General).

Diagnostics.

Contact Rosemount Service
Department®.

(1) A malfunctioning display panel may only be replaced by service personnel at Rosemount Service Department. A display must not be replaced

when the transmitter is in operation.
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Device Status

Device Status messages that may appear on the Integral Display, on the

275/375 Handheld Communicator or in the Rosemount Radar Master (RRM)
program are shown in Table 6-2:

Table 6-2. Device status.

Message
Running Boot Software

Description

The application software could not be
started.

Action

Contact Rosemount Service
Department.

Device Warning

A device warning is active.

See Warning Messages for details.

Device Error

A device error is active.

See Error Messages for details.

Simulation Mode

The simulation mode is active.

Turn off the simulation mode.

Advanced Simulation Mode

The advanced simulation mode is
active.

To turn off the Advanced Simulation
mode set Holding Register 3600=0
(see “Viewing Input and Holding
Registers” on page 6-2).

Invalid Measurement

The level measurement is invalid.

Check Error Messages, Warning
Messages and Measurement Status
for details.

Software Write Protected

The configuration registers are write
protected.

Use the Lock/Unlock function to turn
off the write protection (see “Write
Protecting a Transmitter” on

page 6-9).

Hardware Write Protected

The Write Protection switch is
enabled.

Set the Write Protection switch to Off.
Contact Rosemount service
department for information.

Factory settings used

The factory default configuration is
used.

The transmitter calibration is lost.
Contact Rosemount Service
Department.

Antenna Contamination

The antenna is extremely
contaminated resulting in degradation
of measurement signal strength.

Clean the antenna.
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Errors

Error messages that may be displayed on the Integral Display, on a 275/375

Handheld Communicator, in AMS or in the Rosemount Radar Master (RRM)
program, are shown in Table 6-3. Errors normally result in Analog Output

alarm.

Errors are indicated in RRM in the Diagnostics window.

Table 6-3. Error messages.

Message
RAM error

Description

An error in the gauge data memory
(RAM) has been detected during the
startup tests. Note: this automatically
resets the gauge.

Action

Contact Rosemount service
department.

FPROM error

An error in the gauge program
memory (FPROM) has been detected
during the startup tests. Note: this
automatically resets the gauge.

Contact Rosemount service
department.

Hreg error An error in the transmitter Load default database and restart the
configuration memory (EEPROM) has | transmitter. Contact Rosemount
been detected. The error is either a service department if the problem
checksum error that can be solved by | persists.
loading the default database or a
hardware error.

NOTE: the default values are used
until the problem is solved.

MWM error An error in the microwave module. Contact Rosemount service

department.

LCD error An error in the LCD. Contact Rosemount service

department.

Modem error Modem hardware failure. Contact Rosemount service

department.

Analog out error An error in the Analog Out Module. Contact Rosemount service

department.

Internal temperature error An error in the internal temperature Contact Rosemount service
measurement. department.

Other hardware error An unspecified hardware error has Contact Rosemount service
been detected. department.

Measurement error A serious measurement error has Contact Rosemount service
been detected. department.

Configuration error

At least one configuration parameter
is outside allowed range.

NOTE: the default values are used
until the problem is solved.

 Load the default database and
restart the transmitter (see “Reset
to Factory Settings” on page 6-8).
Configure the transmitter or upload
a backup configuration file (see
“Backing Up the Transmitter
Configuration” on page 6-4).
Contact Rosemount service
department if the problem persists.

Software error

An error has been detected in the
transmitter software.

Contact Rosemount service
department.

6-12




Reference Manual
00809-0100-4026, Rev DA

March 2006

Rosemount 5400 Series

Warnings

Table 6-4 is a list of diagnostic messages that may be displayed on the
Integral Display, on the 275/375 Handheld Communicator or in the

Rosemount Radar Master (RRM) program. Warnings are less serious than
errors and in most cases do not result in Analog Output alarms.

Warnings are indicated in RRM in the Diagnostics window.

Table 6-4. Warning messages.

Message
RAM warning

FPROM warning

Hreg warning

MWM warning

LCD warning

Modem warning

Analog out warning

Internal temperature warning

Other hardware warning

Measurement warning

Config warning

SW warning

Description

See Diagnostics (RRM: Tools>Diagnostics) for further information on a

warning message.
See also “Diagnostics” on page 6-5.

Action
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Measurement Status

Measurement Status messages that may appear on the Integral Display, on

the 275/375 Handheld Communicator or in the Rosemount Radar Master
(RRM) program are shown in Table 6-5:

Table 6-5. Measurement status.

Message Description Action
Full tank The level measurement is in Full Tank The transmitter leaves the Full Tank state
state. The transmitter waits for the surface | when the product surface gets below the
echo to be detected at the top of the tank. | Full Tank Detection Area, see “Full Tank
Handling” on page C-5 and “Full Tank
Handling” on page C-11.
Empty tank The level measurement is in Empty Tank | The transmitter leaves the Empty Tank

state. The transmitter waits for the surface
echo to be detected at the bottom of the
tank.

state when the product surface gets
above the Empty Tank Detection Area,
see “Empty Tank Handling” on page C-4
and “Empty Tank Handling” on page C-8.

Antenna Contamination

The antenna is so contaminated that the
level measurement might be affected.

Clean the antenna.

Reference pulse invalid

An error in the reference pulse in the last
sampled tank signal.

Check Warning messages. If MicroWave
Module (MWM) Warning is active this
might indicate a transmitter error. Contact
Rosemount service department.

Sweep linearization warning

The sweep is not correctly linearized.

Check Warning messages. If MWM
Warning is active this might indicate a
transmitter error. Contact Rosemount
service department.

Tank signal clip warning

The last Tank Signal was clipped.

Check Warning Messages. If MWM
Warning is active this might indicate a
transmitter error. Contact Rosemount
service department.

No surface echo

The Surface Echo Pulse can not be
detected.

Check if the configuration can be
changed so that the surface echo can be
tracked in this current region.

Predicted level

The presented level is predicted. The
surface echo could not be detected.

See No surface echo above.

Sampling failed

The sampling of the last tank signal failed.

Check Warning Messages.

Invalid volume value

The given volume value is invalid.

Check Volume Status for details.

Simulation Mode

The simulation mode is active. The
presented measurement values are
simulated.

No action needed.

Advanced Simulation Mode

The advanced simulation mode is active.
The given measurements are simulated.

To turn off the Advanced Simulation mode
set Holding Register 3600=0 (see
“Viewing Input and Holding Registers” on
page 6-2).

Tracking Extra Echo

The transmitter is in the empty tank state
tracking an extra echo.

See “Extra Echo” on page C-5 and
page C-10.

Bottom Projection

The bottom projection function is active.

See “Tank Bottom Projection” on
page C-4.

Using pipe measurement

Pipe Measurement is active.

No action needed.

Surface close to registered
false echo.

Close to a registered false echo
measurement accuracy may be slightly
reduced.

By using the Register False Echo function
the transmitter can track the product
surface in the vicinity of disturbing objects
(see “Echo Tuning” on page 4-9).

Sudden level jump detected.

This may result from various
measurement problems.

Check the tank to find out what causes
problem tracking the surface.
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Volume Calculation
Status

Table 6-6. Volume status.

Message

point.

Level is below lowest strapping

Description

The measured level is below the
lowest point in the given strapping
table.

Volume Calculation Status messages that may appear on the Integral Display,
on the 275/375 Handheld Communicator or in the Rosemount Radar Master
(RRM) program are shown in Table 6-6:

Action

For a correct volume calculation in
this region change the strapping
table.

point.

Level is above highest strapping

The measured level is above the
highest point in the given strapping
table.

For a correct volume calculation in
this region change the strapping
table.

Level out of range.

The measured level is outside the
given tank shape.

Check if the correct tank type is
chosen and check the configured
Tank Height.

Strap table length not valid.

The configured strap table length is
too small or too large.

Change the strapping table size to a
valid number of strapping points. A
maximum number of 20 strapping
points can be entered.

Strap table not valid.

The strapping table is not correctly
configured.

Check that both level and volume
values in the strapping table are
increasing with strapping table index.

Level not valid.

The measured level is not valid. No
volume value can be calculated.

Check Measurement Status, Warning
and Error Messages.

Volume configuration missing.

No volume calculation method is
chosen.

Do a volume configuration.

Volume not valid.

The calculated volume is not valid.

Check the other volume status
messages for the reason.

Analog Output Status

Table 6-7. Analog Output
status.

Message

Not connected

Description

Analog output hardware is not
connected.

Analog Output Status messages that may appear on the Integral Display, on
the 275/375 Handheld Communicator or in the Rosemount Radar Master
(RRM) program are shown in Table 6-7:

Action

Alarm Mode

The analog output is in Alarm Mode.

Check Error and Warning Messages
to find the reason for the Alarm.

Saturated

The analog output signal value is
saturated, i.e. equal to the saturation
value.

No action needed.

Multidrop

The transmitter is in Multidrop Mode.
The analog output is fixed at 4 mA.

This is the normal setting when a
device is used in Multidrop
configuration.

Fixed Current mode

The analog output is in fixed current
mode.

This mode is used when calibrating
the Analog Output channel.

Invalid Limits

The given Upper and Lower Range
Values are invalid.

Check that the difference between the
Upper and Lower Range Value is
greater than the Minimum Span.
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Application Errors

100 %

0%

APPLICATION_ERROR_1.EPS

Alarm.

time

When product surface is close to
the tank bottom the transmitter
enters alarm mode (see “Alarm
Mode” on page 4-7).

May be caused by reduction of projected
surface area close to sloping tank bottom.

Action:

* Increase parameter Empty Tank
Detection Area if measurement in this
region is not crucial, see “Empty Tank
Detection Area” on page C-4 and C-9.
Make sure that the Bottom Echo
Visible parameter is not set, see
“Bottom Echo Visible” on page C-4
and C-8.

100 %

0%

APPLICATION_ERROR_2.EPS

time

Incorrect level.

Action:
» Check the Tank Height configuration.
« If there are rapid level changes check
the Damping Value, see “Damping
Value” on page C-7.

100 %

0%

APPLICATION_ERROR_RANGEVALUE.EPS

time

Incorrect level.

May be caused by wrong Range Value
settings.
Action:
» Check that the Upper Range Value
matches the 100 % level in the tank.

100 %

0%

APPLICATION_ERROR_RANGEVALUE.EPS

time

Incorrect level when using a
pipe.

May be caused by wrong configuration of
Pipe Inner Diameter.
Action:
* Check that the actual Pipe Inner
Diameter matches the configured
Inner Diameter.
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100 %

0%

APPLICATION_ERROR_3.EPS

time

Measured value gets stuck.

May be caused by disturbing object in the
tank
Action:

* Remove disturbing object in the tank.

* Move the transmitter to another
position or turn the transmitter 90°.

» Use the Echo Tuning function in RRM
to register the false echo that causes
the transmitter to lock on the wrong
level, see “Echo Tuning” on page 4-9.

» Put an inclined metal plate on top of
the disturbing object.

100 %

0%

APPLICATION_ERROR_EMPTY.EPS

time

Measured value drops to zero
level.

May be caused by strong echoes from the
tank bottom when product is slightly
transparent.

Action:

» Check Tank Height.

» Make sure that the Bottom Echo
Visible parameter is enabled, see
“Bottom Echo Visible” on page C-4
and C-8.

Try using the Tank Bottom Projection
function if the following conditions are
fulfilled:

- The product is transparent.

- The tank bottom echo is visible.

- The Bottom Echo Visible parameter
is enabled.

100 %

0%

time

Measured value drops to zero
level.

(You can verify Empty Tank state
by opening the Tank Display
window in RRM).

If the transmitter loses track of the surface
within the Empty Tank Detection Area the
tank is considered empty. See section
“Empty Tank Detection Area” on page C-4
and C-9.

Action:
If possible try another mounting position.

100 %

APPLICATION_ERROR_EMPTYTANK.EPS

0%

APPLICATION_ERROR_JUMPLOW.EPS

time

Measured level jumps to a lower
value.

May be caused by:
» Two products layered in the tank.

Action:

» Enable the Double Surface function,
see “Surface Echo Tracking” on
page C-6.

RRM: Setup>Advanced.
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APPLICATION_ERROR_DOUBLEBOUNCE.EPS

100 %

0%

time

Incorrect level when the product
surface is above the 50% level.

May be caused by:

» Radar echo bouncing off from the
surface to the tank roof and back to
the surface.

* Product with very high reflectivity
causing very strong echoes.

Action:

* Move the transmitter away from the
center of the tank roof.

» Enable the Double Bounce function,
see “Double Bounce” on page C-5
and C-12.

RRM: Setup>Advanced.

APPLICATION_ERROR_AROUNDSTABLE.EPS

100 %

0%

time

Measured level jumps to a
higher value.

May be caused by:
» Foam on the product surface.
 Turbulent product surface.

Action:

» Enable the Tank Environment Foam
parameter.
RRM: Setup>Tank>Environment.
HART: [1,3,4,5,1].

» Enable the Tank Environment
Turbulent Surface parameter.
RRM: Setup>Tank>Environment.
HART: [1,3,4,5,1].

APPLICATION_ERROR_TOP.EPS

100 %

0%

Measured level gets stuck near
the top of the tank.

May be caused by:
» Antenna tip ends inside the tank
nozzle.
« Disturbing objects near the antenna.

Action:
* If possible mount the transmitter on
another nozzle.
« Increase the Hold Off distance.
RRM: Setup>Advanced.
HART: [1,4,5,4].

APPLICATION_ERROR_FULLTANK.EPS

100 %

0%

time

The level value drops to a lower
value when the product surface
is close to the antenna.

May be caused by:

» Product level is within the Hold Off
region, i.e. outside the approved
measuring range, and the transmitter
picks up secondary signal reflections.

Action:

* Avoid filling the tank to levels very
close to the antenna.
If possible, move the transmitter to
increase the distance between
maximum product level and antenna.
Activate the Full Tank Handling
function if measurements up to the
antenna are required, see “Full Tank
Handling” on page C-5 and C-11.
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The transmitter presents May be caused by:

“measurement error” and * Product level is within the Hold Off

activates Measurement Alarm region, i.e. outside the approved

when the product level is close measuring range.

to the antenna. Action:

« Avoid filling the tank to levels very

close to the antenna.

If possible, move the transmitter to

increase the distance between

maximum product level and antenna.

Activate the Full Tank Handling

0% function if measurements up to the
time antenna are required, see “Full Tank

Handling” on page C-5 and C-11.

100% Alarm

APPLICATION_ERROR_UNSTABLE.EPS

APPLICATION_ERROR_FULLTANK_ALARM.EPS

The measured level is unstable. | May be caused by:
* The tank is empty and the Amplitude
Threshold is too low.
» Product surface is close to a
registered False Echo.
Action:
» Create a new Amplitude Threshold
Curve, see “Echo Tuning” on
page 4-9.

100 %

0%

time
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Specifications . ....... . ... page A-1
Dimensional Drawings . ............ ... page A-5
Ordering Information ............. .. ... .. ... .. .... page A-8
SPECIFICATIONS
General
Product Rosemount 5400 Series Radar Level Transmitter.
Measurement Principle Pulsed, free propagating radar.
5401: ~6 GHz
5402: ~26 GHz
Microwave Output Power <1lmw
Beam Angle See “Beamwidth” on page 3-7.

Measuring Performance

Measuring Range
Instrument Accuracy®
Dead Zone®

Near Zone Distance
Near Zone Accuracy

Resolution

Repeatability
Temperature Drift
Update Interval

Max Level Rate

Display / Configuration

Integral Display
Output Variables

Output Units

Configuration Tools

(1) Reference conditions:

98 ft (30 m) from flange.

5401: £ 0.4 in. (+ 10 mm). 5402; £ 0.1 in. (+x 3 mm).

Cone antenna: 5.9 in. (150 mm) from antenna lower end.

Rod antenna: 2.0 in. (50 mm) from antenna lower end.

Process Seal: lowest value of 150 mm under antenna lower end and from lower end of
nozzle.

Cone and Rod antennas: 1.3 ft (0.4 m) from antenna lower end.

Process Seal antennas: lower end of nozzle.

5401: £ 1.2 in. (+ 30 mm). 5402: £0.6 in (15 mm) for all antennas except the 2-in. Process
Seal antenna which has £ 1.2 in. (+ 30 mm) accuracy.

0.04 in. (1 mm)

+ 0.04 in. (+ 1 mm) at 16 ft (5 m) distance.

0.05 %/10 K in temperature range -40°F to 176°F (-40 °C to 80 °C).

1 second.

1.6 in./s (40 mm/s) as default, adjustable to 7.9 in./s (200 mm/s).

5-digit integral display. The process variables listed below can be presented. If more than
one variable is chosen, carousel toggling of data is used. The display also shows
diagnostics and error information.

Level, Distance, Volume, Level Rate, Signal Strength, Internal Temperature, Analog Output
Current and % of Range.

Level and Distance: ft, inch, m, cm or mm

Level Rate: m/s, ft/s

Volume: ft3, inch®, US gals, Imp gals, barrels, yd®, m® or liters

Temperature: degree Fahrenheit, degree Celcius

HART®: Rosemount Radar Master (RRM), 275/375 Handheld Communicator, AMS Suite, or
any DD- or EDDL-compatible host.

Temperature: 68 °F (20 °C).
Pressure: 14-15 psi (960-1060 mBar).
Humidity: 25-75 % RH.
Metal plate, no disturbing objects.
(2) Dead zones are areas where measurements are not recommended.

ROSEMOUNT EMERSON

Www.rosemount.com Process Management
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Electric
Power Supply

Internal Power Consumption
Output
Signal on Alarm (configurable)

Saturation Levels

IS Parameters
Cable Entry
Output Cabling
Mechanical

Antennas

Material exposed to Tank Atmosphere

Housing / Enclosure
Dimensions
Weight, excl. flange
Environment

Ambient Temperature®

Storage Temperature
Process Temperature®
Process Pressure®
Humidity

Factory Sealed

Ingress Protection

EU Directive compliance

Telecommunication (FCC and R&TTE)®

Electromagnetic Compatibility

Transient / Built-in Lightning Protection

Pressure Equipment Directive (PED)

16-42.4 VDC (16-30 VDC in IS applications and 20-42.4 VDC in
Explosion-proof/Flameproof applications).
< 50 mW in normal operation.

HART® 4-20 mA current loop.

Standard: Low=3.75 mA, High=21.75 mA.
Namur NE43: High=22.5 mA.

Standard: Low=3.9 mA, High=20.8 mA.
Namur NE43: High=20.5 mA.

See Section B: Product Certifications.

1/2 in. NPT or optional M20x1.5 adapter.
24-12 AWG, twisted shielded pairs.

See page A-8. Antenna material exposed to tank atmosphere: depends on antenna type,
see “Ordering Information” on page A-8.

Cone Antenna

+316 /316 L SST (EN 1.4404) or Monel® 400 (UNS NO4400) or Hastelloy® C-276 (UNS
N10276). Monel® and Hastelloy® antennas have a plate design.

* PTFE fluoropolymer

* O-ring material

Rod Antenna, Two versions

« All-PFA® fluoropolymer

« PFA® fluoropolymer, 316 / 316 L SST (EN 1.4404) and O-ring material

Process Seal Antenna

* PTFE fluoropolymer

* O-ring material

For more information see “Ordering Information” on page A-8.

Polyurethane-covered Aluminum
See “Dimensional Drawings” on page A-5.
2.0kg (4.4 Ib)

Non-Hazardous: -40°F to 176 °F (-40 °C to 80 °C).

IS/EExX ia and XP/EEx d, HART® communication: -40°F to 158 °F (-40 °C to 70 °C).
LCD readable in -4 °F to 158 °F (-20°C to 70 °C).

-58°F to 194°F (-50°C to 90°C). LCD: -40°F to 185°F (-40°C to 85°C).

See “Process Temperature and Pressure Rating” on page A-3.

See “Process Temperature and Pressure Rating” on page A-3.

0 - 100% Relative Humidity, non condensating.

Yes

Type 4X, IP66, IP67.

CE mark, 93/68/EEC

FCC part 15C (1998) and R&TTE (EU directive 1999/5/EC).

Emission and Immunity:

EMC directive 89/336/EEC. EN61326-1:1997 incl. A1:1998 and A2:2001.

NAMUR recommendations NE21.

EN61326, IEC 801-5, level 1 kV. T1 option: complies with IEEE 587 Category B transient
protection and IEEE 472 surge protection.

97/23/EC.

(1) PFA s a fluoropolymer with properties similar to PTFE.

(2) Depends on O-ring selection. The maximum ambient temperature also depends on the process temperature: for every process temperature degree above
185 °F (85 °C) the maximum ambient temperature is reduced by 0.27 °F/0.15 °C.

(3) Final rating depends on flange and O-ring selection. See “Process Temperature and Pressure Rating” on page A-3 and “Ordering Information” on

page A-8.

(4) The 5402 is authorized for use in tank-mounted applications, including metal tanks, as well as concrete, plastic, glass and other non-conductive tanks.
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PROCESS
TEMPERATURE AND
PRESSURE RATING

Rod and Cone Antenna

Figure A-1. Process
temperature and pressure
diagram for Rosemount 5400
Series with Cone or Rod
antenna.

PT_CONE_ROD.EPS

Table A-1. Tank Seal
temperature range depending

on selection of O-ring materials.

The temperature/pressure rating depends on the design of the transmitter in
combination with Tank Seal O-ring, flange and gasket materials.

Working Pressure

Max Working Pressure for the Rosemount 5400 with Rod or Cone antenna is
145 PSI/10 bar.

Pressure psig (bar)

\ Temperature rating may be 1%

145 (10) limited by flange and O-ring 0
selection, see Table A-1 Q

=

<

[hd

LIJI

o

=)

[9]

n

11}

@

Temperature °F (°C) &

-14(-1) o =
-40 (-40) 302 (150) =

Temperature restrictions due to O-ring selection

The Tank Seal has an O-ring sealing which is selected depending on the
specific temperature and product requirements. The following table®
presents the applicable temperature ranges:

Tank Seal of different O-ring Min. Temperature

Max. Temperature

materials °F (°C) in air °F (°C) in air
Viton® -4 (-20) 302 (150)
Ethylene Propylene (EPDM)  -40 (-40) 302 (150)
Kalrez 6375 5 (-15) 302 (150)
Buna-N -40 (-40) 230 (110)

Pressure restrictions due to flange selection

The maximum allowed pressure may also be limited by the flange rating. The
5400 Series flange has the same p/T rating as the corresponding blind flange:

ANSI: according to ANSI B16.5 Table 2-2.3.
EN: according to EN 1092-1 Table 18, material group 13EO.

(1) Not applicable for the All-PFA rod antennas (1R and 2R).
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Process Seal Antenna

Figure A-2. Process
temperature and pressure

diagram for Rosemount 5400 Pressure psig (bar)
Series with Process Seal A
antenna. 120 (8.2)

90 (6.2)

10 (0.69)
Temperature
-15 (-1) » ‘F(°C)

-4 (-20) 104 (40) 212 (100) 302 (150)

TEMP_PRESSURE_PROCESSSEAL.EPS

PT_PROCESSSEAL.EPS

Temperature restrictions due to O-ring selection

The Process Seal window has a process O-ring which is selected depending
on the specific temperature and product requirements. The following table
presents the applicable temperature ranges:

Table A-2. Process Seal

temperature range depending O-ring materials Min. Temperature Max. Temperature
on selection of O-ring materials. °F (°C) in air °F (°C) in air
Viton® -4 (-20) 302 (150)
Ethylene Propylene (EPDM) -4 (-20) 275 (135)
Kalrez 6375 23 (-5) 302 (150)
Buna-N -4 (-20) 257 (125)
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DIMENSIONAL
DRAWINGS

Figure A-3. Model 5401 (Low

Frequency version) transmitter 7.1 (180) 5.2 (133)
with cone antenna.
3.5(88) 3.6(92)

% - 14 NPT

Optional

adapters:

) M20x1.5 @
i 7.3 (185)

9.4 (240) ﬁ% %i ]
s60

— >

(7]
i
| uw
-
U)I
{ \ &
A )
Z
]
! =
5 Dimensions are in inches (mm) e
Figure A-4. Model 5402 (High
Frequency version) transmitter 7.1 (180) 5.2 (133)
with cone antenna. 35(88) 3.6 (92)
Y% - 14 NPT
Optional
adapters:
. M20x1.5
> 7.3 (185)
9.4 (240)
s60
NOTE | 0
Hastelloy® and Monel® m
antennas have a plate design. A f,l
8
]
P
s
B Dimensions are in inches (mm) &)

5401 5402

Material Cone size (inch) Ainch (mm) B inch (mm) Material Cone size (inch) Ainch (mm) B inch (mm)
SST, 3 3.3(84) 2.6 (67) SST 2 6.5 (165) 2.0 (50)
Hastelloy® 4 5.9 (150) 3.6 (92) 3 5.9 (150) 2.6 (67)
and Monel® 6 7.3 (185) 5.5 (140) . 0.8 (225 26 (02
8 10.6 (270) 7.4 (188) 8(225) -6(92)
Hastelloy® 2 5.9 (150) 2.0 (50)
and Monel® 3 6.9 (175) 2.6 (67)
4 9.8 (250) 3.6 (92)
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Figure A-5. 5400 Series
transmitter with rod antenna.

7.1 (180) 5.2 (133)
35(88) 3.6(92)

Y%inch. - 14 NPT

Optional adapter:
M20x1.5 é
@ B 7.3 (185)
a)
9.4 (240)
___—s60
| | | NPT 1% inch
Optional PFA plate B
A
0
o
L
a
o
14
o
P
[}
2]
4
]
=
. &)
1.5 (38)
Rod size A inch (mm) B inch (mm)
Short 14.4 (365) 3.94 (100)
Long 20.3 (515) 9.84 (250)

NOTE

All-PFA rod antennas (1R and 2R) have a PFA plate and are therefor only
available with flanged connection. SST+PFA rod antennas (3R and 4R),
which are not equipped with a PFA plate, are available either with flanged or
threaded connection.
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Figure A-6. 5400 Series
transmitter with Process Seal

antenna.
7.1 (180) 5.2 (133)

35(88) 3.6(92)

Y%inch. - 14 NPT
Optional adapter:
M20x1.5 @
7.3 (185)
S {
s60
B
[
o
w
-
<
L
(]
o
| | | | 2
@)
| | | | e
4
o
C @
Z
)
%)
zZ
L
s
A a
Process Seal
size (inch) A B C
2 1.8 (46) 14.2 (360) 0.9 (22)
3 2.8(72) 17.3 (440) 1.4 (35)
4 3.8(97) 18.9 (480) 1.9 (48)
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ORDERING INFORMATION

Model Code for Rosemount 5401 Radar Level Transmitter
Model Product Description

5401 Low frequency version (~6 GHz)

Code Housing Material

Polyurethane-covered Aluminum

Code Signal Output
H 4-20 mA with HART® communication

FOUNDATION™ fieldbus

Code Conduit / Cable Threads

1/2 inch - 14 NPT
M20 x 1.5 adapter

Code Product Certifications

No Hazardous Locations Certifications

E1l ATEX Flameproof

11 ATEX Intrinsic Safety

IA ATEX FISCO Intrinsic Safety®
E5 FM Explosion-Proof

15 FM Intrinsic Safety and Non-incendive
IE FM FISCO Intrinsic Safety®
E6 CSA Explosionproof

16 CSA Intrinsic Safety

IF CSA FISCO Intrinsic Safety®
E7 IECEx Flameproof

I7 IECEX Intrinsic Safety

IECEx FISCO Intrinsic Safety®

Code Antenna - Size and Material

Cone Antennas

3S 3in. DN 80, 316 L SST (EN 1.4404), pipe installations only
4S 4in. DN 100, 316 L SST (EN 1.4404)
6S 6 in. DN 150, 316 L SST (EN 1.4404)
8S 8in. DN 200, 316 L SST (EN 1.4404)
3H 3in. DN 80, Hastelloy® C-276 (UNS N10276)@ with plate design, pipe installations only
4H 4 in. DN 100, Hastelloy® C-276 (UNS N10276)® with plate design
6H 6 in. DN 150, Hastelloy® C-276 (UNS N10276)® with plate design
8H 8 in. DN 200, Hastelloy® C-276 (UNS N10276)@ with plate design
3M 3in. DN 80, Monel® 400 (UNS N04400)® with plate design
4M 4 in. DN 100, Monel® 400 (UNS N04400)® with plate design
6M 6 in. DN 150, Monel® 400 (UNS N04400)® with plate design
8M 8 in. DN 200, Monel® 400 (UNS N04400)® with plate design
Rod Antennas
1R 100 mm inactive length, all-PFA®®
2R 250 mm inactive length, all-PFA®®
3R 100 mm inactive length, SST+ PFA®
4R 250 mm inactive length, SST+ PFA®
Other Antennas
XX Customer specific
Tank Sealing
PV PTFE with Viton® fluoroelastomer o-rings
PK PTFE with Kalrez® 6375 perfluoroelastomer o-rings
PE PTFE with EPDM o-rings
PB PTFE with Buna-N o-rings
PD All-PFAGI®)
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Code Process Connection and Material

ANSI Flanges

AA 2 inch, 150 Ibs, 316 / 316 L SST®

AB 2 inch, 300 Ibs, 316 / 316 L SST®

BA 3inch, 150Ibs, 316 / 316 L SST

BB 3inch, 300 Ibs, 316 /316 L SST

CA 4 inch, 150 Ibs, 316 / 316 L SST

CB 4 inch, 300 Ibs, 316 / 316 L SST

DA 6 inch, 150 Ibs, 316 / 316 L SST

EA 8inch, 150 Ibs, 316 / 316 L SST
EN (DIN) Flanges

HB DN 50 PN 40, SST (EN 1.4404)®

1B DN 80 PN 40, SST (EN 1.4404)

JA DN 100 PN 16, SST (EN 1.4404)

JB DN 100 PN 40, SST (EN 1.4404)

KA DN 150 PN 16, SST (EN 1.4404)

LA DN 200 PN 16, SST (EN 1.4404)
Threaded

RA 1.5-in. NPT, 316 L SST (EN 1.4404)
Other Flanges

XX Customer specific
Options

M1 Integral digital display

BT Bar Code Tag with tag number and purchase order number

T1 Transient Protection Terminal Block (standard with FISCO options)
Software Configuration

C1 Factory configuration (CDS required with order)
Alarm Limit Configuration

C4 NAMUR alarm and saturation levels, high alarm

Cc8 Low alarm® (standard Rosemount alarm and saturation levels)
Special Certificates

Q4 Calibration Data Certificate

Q8 Material Traceability Certification per EN 10204 3.1B®)
Special Procedures

P1 Hydrostatic testing

Typical Model Number: 5401 AH1E54S PV CA-M1C1

(1) Requires Foundation™ fieldbus signal output (U; parameter listed in “Product Certifications”).
(2) Requires flange of same size.

(3) PFAis a fluoropolymer with properties similar to PTFE.

(4) Requires All-PFA tank seal (PD).

(5) Requires All-PFA Rod antennas (1R or 2R).

(6) Requires Rod antennas (1R, 2R, 3R or 4R)

(7) Requires Rod antenna in SST+Teflon (3R or 4R).

(8) Standard alarm setting is high.

(9) Option available for pressure retaining wetted parts.
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Model Code for Rosemount 5402 Radar Level Transmitter
Model Product Description

5402 High frequency version (~26 GHz)

Code Housing Material

Polyurethane-covered Aluminum

Code Signal Output

H 4-20 mA with HART® communication
F FOUNDATION™ fieldbus
Code Conduit / Cable Threads

1 1/2 inch - 14 NPT
2 M20 x 1.5 adapter
Product Certifications
NA No Hazardous Locations Certifications
E1l ATEX Flameproof
11 ATEX Intrinsic Safety
IA ATEX FISCO Intrinsic Safety®
E5 FM Explosion-Proof
15 FM Intrinsic Safety and Non-incendive
IE FM FISCO Intrinsic Safety™
E6 CSA Explosionproof
16 CSA Intrinsic Safety
IF CSA FISCO Intrinsic Safety®
E7 IECEx Flameproof
17 IECEX Intrinsic Safety
IG IECEx FISCO Intrinsic Safety®
Code Antenna - Size and Material
Cone Antennas
2S 21in. DN 50, 316 L SST (EN 1.4404)@
3S 3in. DN 80, 316 L SST (EN 1.4404)
4S 4in. DN 100, 316 L SST (EN 1.4404)
2H 2 in. DN 50, Hastelloy® C-276 (UNS N10276)® with plate design
3H 3in. DN 80, Hastelloy® C-276 (UNS N10276)@ with plate design
4H 4 in. DN 100, Hastelloy® C-276 (UNS N10276)® with plate design
2M 2 in. DN 50, Monel® 400 (UNS N04400)@ with plate design
3M 3in. DN 80, Monel® 400 (UNS N04400)® with plate design
4M 4 in. DN 100, Monel® 400 (UNS N04400)® with plate design
Process Seal Antennas
2P 2in. DN 50, PTFE®
3P 3in. DN 80, PTFE®
4p 4in. DN 100, PTFE®
Other Antennas
XX Customer specific
Tank Sealing
PV PTFE with Viton® fluoroelastomer o-rings
PK PTFE with Kalrez® 6375 perfluoroelastomer o-rings
PE PTFE with EPDM o-rings
PB PTFE with Buna-N o-rings
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Code Process Connection and Material

ANSI Flanges

AA 2 inch, 150lbs, 316 / 316 L SST®

AB 2 inch, 300 Ibs, 316 / 316 L SST®

BA 3inch, 150lbs, 316 / 316 L SST

BB 3inch, 300 Ibs, 316 / 316 L SST

CA 4 inch, 150 Ibs, 316 / 316 L SST

CB 4 inch, 300 Ibs, 316 / 316 L SST

DA 6 inch, 150 Ibs, 316 / 316 L SST

EA 8inch, 150 Ibs, 316 / 316 L SST
EN (DIN) Flanges

HB DN 50 PN 40, SST (EN 1.4404)®

1B DN 80 PN 40, SST (EN 1.4404)

JA DN 100 PN 16, SST (EN 1.4404)

JB DN 100 PN 40, SST (EN 1.4404)

KA DN 150 PN 16, SST (EN 1.4404)

LA DN 200 PN 16, SST (EN 1.4404)
Other Flanges

XX Customer specific
Options
Integral digital display

BT Bar Code Tag with tag number and purchase order number

T1 Transient Protection Terminal Block (standard with FISCO options)
Software Configuration

C1 | Factory configuration (CDS required with order)
Alarm Limit Configuration

C4 NAMUR alarm and saturation levels, high alarm

Cc8 Low alarm(” (standard Rosemount alarm and saturation levels)
Special Certificates

Q4 Calibration Data Certificate

Q8 Material Traceability Certification per EN 10204 3.1B®)
Special Procedures

P1 Hydrostatic testing

Typical Model Number: 5402 AH1E54SPVCA-M1C1

(1) Requires Foundation™ fieldbus signal output (U; parameter listed in “Product Certifications”).
(2) Requires flange of same size.

(3) Requires 2in./ DN 50 flanges (AA, AB or HB).

(4) Requires 3in./ DN 80 flanges (BA, BB or IB).

(5) Requires 4 in./ DN 100 flanges (CA, CB, JA or JB).

(6) Requires a 2 inch antenna (code 2S).

(7) Standard alarm setting is high.

(8) Option available for pressure retaining wetted parts.
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Appendix B

SAFETY MESSAGES

ROSEMOUNT

Product Certifications

Safetymessages . ... page B-1
EU Conformity . ... page B-2
European ATEX Directive Information ............... page B-3
Hazardous Locations Certifications ................. page B-5
Approval Drawings . ......... .o page B-9

Procedures and instructions in this section may require special precautions to
ensure the safety of the personnel performing the operations. Information that
raises potential safety issues is indicated by a warning symbol (A). Please
refer to the following safety messages before performing an operation
preceded by this symbol.

Explosions could result in death or serious injury:

Verify that the operating environment of the gauge is consistent with the appropriate
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make
sure the instruments in the loop are installed in accordance with intrinsically safe or
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

Failure to follow safe installation and servicing guidelines could result in death or
serious injury:

Make sure the transmitter is installed by qualified personnel and in accordance with
applicable code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are
qualified.

Substitution of components may impair Intrinsic Safety.

To prevent ignition of flammable or combustible atmospheres, disconnect power before
servicing.

EMERSON.

Wwww.rosemount.com

Process Management
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High voltage that may be present on leads could cause electrical shock:
Avoid contact with leads and terminals.

Make sure the main power to the Radar Transmitter is off and the lines to any other
external power source are disconnected or not powered while wiring
the gauge.

Antennas with non-conducting surfaces (e.g. Rod Antenna and All PTFE antenna) may
generate an ignition-capable level of electrostatic charge under certain extreme
conditions. Therefore, when the antenna is used in a potentially explosive atmoshpere,
appropriate measures must be taken to prevent electrostatic discharge.

EU CONFORMITY The EC declaration of conformity for all applicable European directives for this
product can be found on the Rosemount website at www.rosemount.com. A
hard copy may be obtained by contacting our local sales representative.
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EUROPEAN ATEX
DIRECTIVE
INFORMATION

Intrinsic Safety

Figure B-1. Approval Label ATEX

The Rosemount 5400 Series Transmitter that has the following label attached
has been certified to comply with Directive 94/9/EC of the European
Parliament and the Council as published in the Official Journal of the
European Communities No. L 100/1 on 19-April-1994.

540
TAG
MFG
SN
HART®4-20mA  suppr
25 A [NON-LS)
FCT 1D HBC54Dx ENCL TYPE £k PS5, IP67

WAY BE PROTECTED 3Y USAUD FOREIGN
ATENTS ANDPATENTS FENDING,

HILLINSNYYL TAATT MY avy

Ui: 30V, li: 130mA, Pi: 1.0W
Li=0 Ci=7.26 nF

=] ARHART

| 082 O E
o c € 0575 2
%‘ " &M 1601730 )
& PLACE FOR NON EExia lIC T4 (-50°C<Ta<70°C} o
§ ATEX INFORMATION” Nomko MATEXIOTSX =

Z

3

I1  The following information is provided as part of the label of the
transmitter:

* Name and address of the manufacturer (Rosemount).
» CE Conformity Marking

c € 0575

» Complete model number

* The serial number of the device
* Year of construction

» Marking for explosion protection:

@u 1GDT73°C

« EExiallC T4 (-50 °C < Ta < +70 °C)®

e 4-20 mA/HART model: Ui=30V, li=130 mA, Pi=1.0 W, Ci=7.26 nF, Li=0.
* Nemko ATEX certificate number: Nemko 04ATEX1073X

 Installation Drawing: 9150 079-907

Special Conditions for Safe Use (X):

The intrinsically safe circuits do not withstand the 500V AC test as specified in
EN 50020 clause 6.4.12.

Parts of the rod-antenna and the All PTFE antenna are non-conducting and
the area of the non-conducting part exceeds the maximum permissible areas
for Group IIC according to EN 50014 clause 7.3 (20 cm?) and Category Il 1 G
according to EN 50284 clause 4.4.3 (4 cm?). Therefore, when the antenna is
used in a potentially explosive atmosphere, appropriate measures must be
taken to prevent electrostatic discharge.

Impact and friction hazards need then to be considered according to EN
50284 clause 4.3.1 when the transmitter and part of antennas exposed to the
exterior atmosphere of the tank is made with light metal alloys and used in
category 111 G.

(1) Other temperature restrictions may apply, please refer to “Specifications” on page A-1.
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Flameproof

Figure B-2. Approval Label ATEX

B-4

The Rosemount 5400 Series Transmitter that has the following label attached
has been certified to comply with Directive 94/9/EC of the European
Parliament and the Council as published in the Official Journal of the
European Communities No. L 100/1 on 19-April-1994.

540,
TAG
MFG
SM

HART® 4-20mA  SvPPLY:

= AL
c €

FOD 1D KECH0n ENCL. TEPE &IPS, 5T
hwir BE PROTECTED BY LIS AMD FOREIGN
P 1|

HALLINSNYHL TEATT HYIve

NITINE DUOGE 105 =

c € 0682 ©
0575
" &n1z260T73°¢
PLACE FOR NON EEx iad IIC T4
» -40°C<Ta<+70°C
ATEX INFORMATION Lem n:Amm}m
Um=250V

& xuHART

LABEL_ATEX_EXIAD.TIF

E1 The following information is provided as part of the label of the
transmitter:

* Name and address of the manufacturer (Rosemount).
» CE Conformity Marking

c € 0575

» Complete model number

* The serial number of the device
* Year of construction

» Marking for explosion protection:

@u 1/2 GDT73°C

+ EExiad lIC T4 (-40 °C<Ta< +70 °C)
* Nemko ATEX certificate number: Nemko 04ATEX1073X

Special Conditions for Safe Use (X):

The intrinsically safe circuits do not withstand the 500V AC test as specified in
EN 50020 clause 6.4.12.

Parts of the rod-antenna and the All PTFE antenna are non-conducting and
the area of the non-conducting part exceeds the maximum permissible areas
for Group IIC according to EN 50014 clause 7.3 (20 cm?) and Category Il 1 G
according to EN 50284 clause 4.4.3 (4 cm?). Therefore, when the antenna is
used in a potentially explosive atmosphere, appropriate measures must be
taken to prevent electrostatic discharge.

Impact and friction hazards need then to be considered according to EN
50284 clause 4.3.1 when the transmitter and part of antennas exposed to the
exterior atmosphere of the tank is made with light metal alloys and used in
category 11 1 G.
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HAZARDOUS The Rosemount 5400 Series Transmitters that have the following labels
LOCATIONS attached have been certified to comply with the requirements of the approval
CERTIFICATIONS agencies noted.

Factory Mutual (FM) Project ID: 3020497.

Approvals

Figure B-3. Approval Labels
Factory Mutual (FM)

540
TAG
MFG

XPCLLDNV 1, GPB,CAD

@ DIP CL W, DV. 1, GRPE,F& G

APPRGYED WITH IS CONNECTIONS TO CLASS LIL IL
DIV.1,6P B, C,D,EF&G

NATIAMS SH0EIL08 —

e
SN g " TEMP. CODE T4 "
R — e PLACE FOR NON mecen C  wplACE FOR NON |
HARTE 420mh = "CE g FM INFORMATION” FM INFORMATION” :
FOC IDx ¥ACS40x  ENCL TYPE 4X, P85, PE7 mrr’?i:;'f‘-m& Wm I

TEMTE AND PATENTS FENCING, & EEAL KOT REGUEED JBART

5400
TAG
MFG
SN

HART® 4-20mA

ISCLI NN, OV, 1.GP A.B.C.D.LEF&G
@ CLI ZONE 0 AExialIC T4 WHEN INSTALLED
APFRDVED DER CONTROL DWG 9150073.905

NICLLDV 2 GPAB,CAD

SUITABLE FOR CLIL 1N

"PLACE FOR NON ovzerescmaxoreraTonazsvasa . PLACE FOR NON
FM INFORMATION” g — FM INFORMATION"

WARNING: SURSSTITUTION OF
MAY IMEAIR SUITABILITY FOR DIV 14 2

NF0INS DH0E3L0S —]

Sunnly:

A2 N0

25 m A {NOHL5) c €
FOU Nk MBS ENCL TYRE 4%, PG, IFi7
MAY BE PROTECTED BY US AND FOREXGH

HILUNSHYHL TIATT WV

WARNING: EXFLOSION BAZARD - D0 NOT DISCONKECT
-] EQUPIENT UULE £ AREA |5 KIOMN TO BE MON-HAZARDOLIS

LABEL_FM_IS_NI.TIF/LABEL_FM_XP_DIP.TIF

E5 Explosion-Proof for Class I, Division 1, Groups B, C and D.

Dust-Ignition proof for Class II/Ill, Division 1, Groups E, F and G with
intrinsically safe connections to Class I, II, lll, Div 1, Groups B, C, D, E, F
and G.

Temperature code T4.
Ambient temperature limits: -40 °C to + 70 °C.
Seal not required.

I5 Intrinsically Safe for Class |, Il, IlII, Division 1, Groups A, B, C, D, E, F
and G.
Class |, Zone 0, AEX ia IIC T4 when installed per Control Drawing:
9150079-905.

Non-incendive for Class I, Division 2, Groups A, B, C and D.

Suitable for Class I, Ill, Division 2, Groups F and G;
Max operation 42.4 V, 25 mA.

Temperature code T4.
Ambient Temperature Limits: -40 °C to + 70 °C.
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Canadian Standards
Association (CSA)
Approval

Figure B-4. Approval Label
Canadian Standards Association
(CSA)

Cert. no. 1514653.

540
TAG
MFG
SN

HART® 4-20mA

Supply: xa-42 AVDC NOK-S} c €

FCE ID:KBCS40 ENCL. TYPE QX IP66 P67
Mat BE FROTECTED B US AMD FOREIGN

@.

YIALLMSNYEL TATT WY Oy
NITINS 'DHIFILOD =

INTRINSICALLY SAFE Exia
CLILOW.1,GP A B CED

CONTROL DWG 9150079906
LREHESY g TEMP, LIMITS -40°C TO +70°C

‘HAANNG; SUBSTITUTION OF COMPONENTS
AT IMPAIR INTRINSIC S4FETY

"PLACE FOR NON
CSA INFORMATION™

KuHART

540
TAG
MFG
SN

HARTE 4-20mA

- C€

FCCID: KBCH40x  BNCL. TYPE4X P, IPET
WY BE PROTECTED BY LS AND FOAEGH

LRsaE

NITIHS 'DH0AIL0D —)

HILLNISNYHL B30 Hvdvd

EXPLOSIONPROOF WITH INTERNAL
INTRINSICALLY SAFE CIRCLNTS [Exia)
CLIIL DIV, 1 AND 2, GPEF &G

AME. TEMP. LIMITS -40°C TO +70°C

WARAMNG: SUBETITUTICH OF COMPLNENTS
MAT IMPAR IMTRINSIC SAFETT

"PLACE FOR NON
CSA INFORMATION™

LABEL_CSA_IS.TIF/LABEL_CSA_XP_DIP.TIF

AHART

B-6

16 Intrinsically Safe Ex ia.

Class |, Division 1, Groups A, B, C and D.

Temperature code T4.

Control Drawing: 9150 079-906.
Ambient temperature limits: -40 °C to + 70 °C.

E6 Explosionproof with internal Intrinsically Safe Circuits [Exia].
Class I, Div. 1, Groups B, C and D.

Temperature Code T4.

Class Il, Div. 1 and 2, Groups E, F and G;

Class Ill, Div. 1

Ambient temperature limits -40 °C to +70 °C.

Factory sealed.
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IECEX Approval

Figure B-5. Approval Label
IECEX Intrinsic Safety

I7 Intrinsic Safety

540,
TAG
MFG
SiN

HART® 4-20mA  supply

——— 24V
25 mA (HON-S)
FCC D <BCHAGx  ENCL. TYPE 4, IP6G, |67

MAY BE PROTECTED BY US AND FOREIGN
PATENTS AND FATENTS FENDING,

"PLACE FOR NON o oo "PLACE FOR NON

ECEx INFORMATION™ (e |IECEx INFORMATION"

NITIMAS 'DEOEIL00 =

HILLWENTYL 1A Hvavy

LABEL_IECEX_EXIL.TIF

X HART

Exia llC T4 (Tymp = -50 °C to +70 °C)Y,

IECEx NEM 06.0001X.

Ui=30V, 1i=130 mA, Pi=1 W, Ci=7.25 nF, Li=0 mH.
Installation Drawing: 9150 079-907.

Conditions of Certification

The intrinsically safe circuits do not withstand the 500V AC test as specified in
EN 50020 clause 6.4.12.

Impact and friction hazards need then to be considered according to IEC
60079-0 clause 8.1.2 when the transmitter and part of antennas exposed to
the exterior atmosphere of the tank is made with light metal alloys and used in
Zone 0.

Parts of the rod-antenna and the All PTFE antenna are non-conducting and
the area of the non-conducting part exceeds the maximum permissible areas
for Group IIC according to IEC 60079-1 clause 7.3: 20 cm? for Zone 1 and 4
cm? for Zone 0. Therefore, when the antenna is used in a potentially explosive
atmosphere, appropriate measures must be taken to prevent electrostatic
discharge.

(1) Other temperature restrictions may apply, please refer to “Specifications” on page A-1.
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E7 Flameproof

Figure B-6. Approval Labels
IECEX Flameproof

w

[~

w zl S
i 1 2
- m <

SN F3 - Exiad IC T4 {40°CSTast70°C) &
HART® 420mA _ 0PFLY =2 PLACE FOR NON IECEx NEM 06.0001X PLACE FOR NON !
=——— il =4 = i}

- ““"“c € £z IECEx INFORMATION” Um0V IECEx INFORMATION” 6

FCG D #805440s  ENCL. TYPE 4K, P65, IF67 é - _|
MAY BE PROTECTED BY LS AND FCREIGN —
PATENTS ANG PATENTS PENDING. = ) HART %

<

)

Ex iad IIC T4 (Tamp :-40° C to +70 °C).
IECEX NEM 06.0001X.

Conditions of Certification

The intrinsically safe circuits do not withstand the 500V AC test as specified in
EN 50020 clause 6.4.12.

Impact and friction hazards need then to be considered according to IEC
60079-0 clause 8.1.2 when the transmitter and part of antennas exposed to
the exterior atmosphere of the tank is made with light metal alloys and used in
Zone 0.

Parts of the rod-antenna and the All PTFE antenna are non-conducting and
the area of the non-conducting part exceeds the maximum permissible areas
for Group IIC according to IEC 60079-1 clause 7.3: 20 cm? for Zone 1 and 4
cm? for Zone 0. Therefore, when the antenna is used in a potentially explosive
atmosphere, appropriate measures must be taken to prevent electrostatic
discharge.
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APPROVAL DRAWINGS

This section contains Factory Mutual and Canadian Standards Association
system control drawings and an ATEX installation drawing. You must follow
the installation guidelines presented in order to maintain certified ratings for
installed transmitters.

This section contains the following drawings:
Saab Rosemount drawing 9150079-905:

System Control Drawing for hazardous location installation of intrinsically safe
FM approved apparatus.

Saab Rosemount drawing 9150079-906:

System Control Drawing for hazardous location installation of CSA approved
apparatus.

Saab Rosemount drawing 9150079-907:

Installation Drawing for hazardous location installation of ATEX and IECEXx
approved apparatus.
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Figure B-7. System Control Drawing for hazardous locat
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Appendix C  Advanced Configuration

Tank Geometry ... ..... .. page C-1
Advanced Analog Output Settings .................. page C-3
Advanced Transmitter Settings . .................... page C-4
Advanced FunctionsinRRM ....................... page C-8

The advanced transmitter configuration includes settings which can be used
to fine tune the transmitter for special applications. Normally, the standard
settings are sufficient.

TANK GEOMETRY

Figure C-1. Advanced Tank Geometry

Tank Reference Point

Distance Offset (GJ)

Hold Off Distance

Tank Height (R)

| ——————— | ProductLevel

TANKGEOMETRY_ADVANCED.EPS

| - /- Lower Reference Point
(Level=0)

— -

Min LevelOffset (C

Distance Offset (G) The Distance Offset is used when hand-dipping is done at a separate nozzle.
By setting the Distance Offset the measured level by the gauge can be
adjusted to correspond with the level value obtained by hand-dipping.

ROSEMOUNT EME§SONH

Www.rosemount.com Process Management
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Minimum Level Offset (C)

Hold Off Distance

Calibration Distance

C-2

The Distance Offset (G) is defined as the distance between the upper
reference point and the flange (the flange is referred to as the Transmitter’s
Reference Point). You can use the Distance Offset to specify your own
reference point at the top of the tank. Set the Distance Offset to zero if you
want the flange as upper reference point. The Distance Offset is defined as
positive if you use an upper reference point above the Upper Reference Point.

The Minimum Level Offset (C) defines a lower null zone which extends the
measurement range beyond the Lower Reference Point down to the tank
bottom. The Minimum Level Offset is defined as the distance between the
Lower Reference Point (Level=0) and the minimum accepted level at the tank
bottom. Set the Minimum Level Offset to zero if you use the tank bottom as
Lower Reference Point. This case corresponds to the standard Tank
Geometry configuration.

Note that the Tank Height must be measured down to the Lower Reference
Point regardless if it is located at the tank bottom or at an elevated point.

This parameter should only be changed if there are disturbing objects close to
the antenna. No valid measurements are possible above the Hold Off
Distance. By increasing the Hold Off Distance the measuring range is
reduced. See “Hold Off Setting” on page C-14 for more information.

The Calibration Distance is by default set to zero. It is used to adjust the
transmitter so that measured levels match hand-dipped or otherwise known
product levels. Normally a minor adjustment is necessary. There may, for
example, be a deviation between the actual tank height and the value
obtained from tank drawings, which usually gets stored in the transmitter
database.
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ADVANCED ANALOG The 20 mA Upper Range Value should be outside the Hold Off Distance (see

OUTPUT SETTINGS “Hold Off Distance” on page C-2) in order to utilize the full range of the analog
output.

Figure C-2. Advanced Range
Value settings

Hold Off Distance

—--_-- 20 mA Upper Range Value (URV)

Product Level - - - b—"

Range 0-100 %

____________________ - __I_ 4 mA Lower Range Value (LRV)

Min LevelOffset (C)

- Lower Reference Point
(Level=0)

ANALOGOUT_ADVANCED.EPS

C-3
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TRANSMITTER

SETTINGS

Antenna Type The transmitter is designed to optimize measurement performance for each

Tank Connection Length

Empty Tank Handling

c-4

available antenna type.

This parameter is pre-configured at factory but may need to be set if a
non-standard antenna is used.

The Tank Connection Length (TCL) parameter is adjusted for each antenna
type in order to optimize measurement performance. TCL is set automatically
for standard antennas. For non-standard antennas (antenna type User
Defined) the TCL value needs to be manually adjusted.

The Empty Tank Handling functions handle situations when the surface echo
is close to the tank bottom:

» Tracking of weak product echoes
» Handling lost echoes

If the surface echo is lost this function makes the transmitter present a
zero-level measurement, and an alarm is activated unless the alarm has been
blocked.

Empty Tank Detection Area

The Empty Tank Detection Area defines a range within a lower limit of 16 in.
(400 mm) and a higher limit of 39 in. (1000 mm) above the tank bottom. If the
surface echo is lost in this region, the tank is considered empty (the device
enters Empty Tank State) and the transmitter presents a zero level reading.

If the tank is empty the transmitter looks in 2 x Empty Tank Detection Area for
the product surface. When a new echo is found it is considered to be the
product surface.

It is important that there are no disturbances in this area. If there are
disturbances they may need to be filtered out.

This function requires that the Bottom Echo Visible function is disabled. The
current Empty Tank Detection Area value is shown in Advanced Setup in
RRM and can be adjusted manually if required, see “Empty Tank Detection
Area” on page C-9.

Bottom Echo Visible

Only set this parameter if the bottom echo is visible. By setting this parameter
the bottom echo will be treated as a disturbance echo to facilitate tracking of
weak surface echoes close to the tank bottom.

Check if the gauge detects the tank bottom when the tank is empty before
activating this function, see “Bottom Echo Visible” on page C-8.

Tank Bottom Projection

This function handles situations close to the tank bottom and may enhance
measurement performance in the tank bottom region. In this region the signal
from the actual tank bottom may in some cases be significantly stronger than
the measurement signal from the product surface.
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Full Tank Handling

Double Bounce

Extra Echo

Extra Echo Detection is used for tanks with domed or conical bottom types
and when no strong echo from the tank bottom exists when the tank is empty.
When the tank is empty an echo beneath the actual tank bottom can
sometimes be seen, see “Extra Echo Function” on page C-10.

Level Alarm is not set when Tank is Empty

If the echo from the product is lost in an area close to the tank bottom (Empty
Tank Detection Area), the device will enter empty tank state and an alarm is
triggered. Two types of alarms are triggered:

« Invalid Level (can be seen in the Diagnostics window).
» The Analog Output enters Alarm Mode.

Full Tank Detection Area

This parameter defines a range where it is accepted to loose the surface
echo. If the echo is lost in this range the tank is considered full (the device
enters Full Tank State) and the device will present max level indication.

When the tank is full the device looks in 2 x Full Tank Detection Area for the
product surface. When a new echo is found in this range it is considered to be
the product surface.

It is important that any disturbances in this area are filtered out.

Level above Hold Off Distance Possible

Enable this function if the level can rise above the Hold Off Distance/UNZ and
you want to display the tank as full in that case. Normally the device will
always be able to track the surface and the product level will never rise that
high. If the checkbox is not enabled and the surface is lost at the top of the
tank the device searches for a surface echo within the whole tank.

Level Alarm is Not Set when Tank is Full

If the surface echo is lost close to the top of the tank, the level value will
normally be displayed as “invalid.” Set this parameter to suppress the “invalid”
display.

NOTE
By setting this parameter the analog output will not enter alarm mode for
invalid levels close to the antenna.

See “Full Tank Handling” on page C-11 for more information.

Some radar waves, after reflection at the surface, are reflected against the
tank roof and back to the surface before they are detected by the transmitter.
Normally, these signals have a low amplitude and are therefore neglected by
the transmitter. For spherical and horizontal cylinder tanks however, in some
cases the amplitude may be strong enough to lead the transmitter to interpret
the double bounce as the surface echo. By setting the Double Bounce
Possible parameter this type of measurement situation can be solved. This
function should only be used if the problem of double bounces can not be
solved by changing the mechanical installation, see “Double Bounce” on
page C-12 for more information.

C-5
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Surface Echo Tracking

C-6

Slow Search

This variable controls how to search for the surface if a surface echo is lost.
With this parameter set, the transmitter starts searching for the surface at the
last known level, and gradually increases the width of the search region until
the surface is found. If this variable is not set the transmitter searches through
the whole tank. This parameter may typically be used for tanks with turbulent
conditions.

Slow Search Speed

This parameter indicates how quickly the search region (Slow Search
window) is expanded when the Slow Search function is active.

Double Surface

Indicates that there are two liquids or foam in the tank resulting in two
reflecting surfaces. The upper liquid or foam layer must be partly transparent
to the radar signal.

If this function is activated, you can specify which surface to select by using
the Select Lower Surface parameter.

Upper Product Dielectric Constant

This is the dielectric constant for the upper product if there is a double surface
situation. A more precise value results in better accuracy for the lower surface
level.

Select Lower Surface

This function should only be used if Double Surface is set. If Select Lower
Surface is set the lower surface will be presented as the product surface. If
not set the upper surface is tracked.

Echo Timeout

Use Echo Timeout to define the time in seconds before the transmitter will
start to search for a surface echo after it has been lost. After an echo has
been lost, the transmitter will not start searching, or trigger any alarms, until
this time has elapsed.

Close Distance Window

This parameter defines a window centered at the current surface position in
which new surface echo candidates can be selected. The size of the window
is xCloseDist. Echoes outside this window will not be considered as surface
echoes. The transmitter will without delay jump to the strongest echo inside
this window. If there are rapid level changes in the tank, the value of the Close
Distance Window could be increased to prevent the transmitter from missing
level changes. On the other hand, a too large value might cause the
transmitter to select an invalid echo as the surface echo.



Reference Manual
00809-0100-4026, Rev DA
March 2006

Rosemount 5400 Series

Filter Settings

Damping Value

The Damping Value parameter determines how quickly the transmitter
responds to level changes and how robust the measurement signal is against
noise. Technically, a damping value of 10 means that in 10 seconds the output
from the transmitter is about 63% of the new level value. Consequently, when
there are rapid level changes in the tank, it may be necessary to decrease the
Damping value for the transmitter to be able to track the surface. On the other
hand, in noisy environments, and if level rates are low, it may be better to
increase the damping value to have a stable output signal.

Activate Jump Filter

The Jump Filter is typically used for applications with turbulent surface and
makes the echo tracking work smoother as the level passes, for example, an
agitator. If the surface echo is lost and a new surface echo is found, the Jump
Filter makes the transmitter wait some time before it jumps to the new echo.
During that time the new echo has to be considered a valid echo.

C-7
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ADVANCED FUNCTIONS

IN RRM

Empty Tank Handling

C-8

Bottom Echo Visible

By enabling the Bottom Echo Visible... parameter the transmitter is able to
separate the product surface from the tank bottom by treating the bottom echo
as a disturbance echo. This is useful for products which are relatively
transparent for microwaves such as oil. For non-transparent products such as
water there is no visible bottom echo until the tank is empty.

To enable this function:

1. Disable the Use Automatic Empty Tank Handling Settings option.
2. Select the Bottom Echo Visible if Tank is Empty check box.

Only use this function for tanks with bottom type Flat where the radar echo
from the tank bottom is clearly visible. If there is no distinct bottom echo even
when the tank is empty this parameter should be disabled. Otherwise, if the
surface echo is temporarily lost, the transmitter starts searching for the
product surface anywhere in the tank and may incorrectly interpret any object
as the surface.

The spectrum function in the RRM program can be used to check if the gauge
detects the tank bottom when the tank is empty.

BOTTOMECHOVISIBLE_SPECTRUM.EPS/EMPTYTANK_BOTTOMECHOVIS.TIF
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Empty Tank Detection Area

The tank is considered empty and the product level is presented as equal to
zero if the signal from the product surface is lost within the region given by the

parameter Empty Tank Detection Area.

If the surface is lost above the Empty Tank Detection Area the transmitter

starts searching for the surface in the entire tank.

You may increase the Empty Tank Detection Area if the surface is lost outside

the Empty Tank Detection Area in a non-critical region of the tank.

1. Disable Use Automatic Empty Tank Handling Settings.

2. Type the desired value in the Empty Tank Detection Area input field.

EMPTYTANKDETECTIONAREA.EPS/EMPTYTANKDETECTIONAREA.TIF
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See “Empty Tank Detection Area” on page C-4 for further information.
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Extra Echo Function

The Extra Echo Detection function makes measurements in the bottom region
more robust for tanks with conical or domed bottom shape. In this case there
is no strong echo from the tank bottom when the tank is empty, and a virtual
echo beneath the actual tank bottom can sometimes be seen.

If the transmitter is not able to detect the tank bottom, this function can be
used to ensure that the transmitter stays in Empty Tank state as long as an
extra echo is present.

Use the spectrum function in Rosemount Radar Master when the tank is
empty to verify if such an echo exists or not. Make sure you enter a distance
that exceeds the tank bottom. In the spectrum you can also view the suitable
values for Extra Echo Min Distance, Extra Echo Max Distance and Extra Echo
Min Amplitude. The tank is considered empty when there is an echo within the
minimum and maximum distance and the amplitude is above the specified
limit.
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Full Tank

Handling The Full Tank Handling function can be used if you want product levels close
to the antenna to be reported as Full Tank. Normally measurements are not
allowed closer to the antenna than specified by the Hold Off Distance
parameter. If the product level enters the Hold Off Distance region, the
transmitter reports Measurement Error and starts searching for the surface.

By setting the Level above Hold Off Distance possible parameter, the
transmitter reports Full Tank when the product level enters the Hold Off
Distance region. Note that:

» The region in which the tank is considered full is specified by the Full
Tank Detection Area.

» The level alarm for Full Tank is normally disabled.

FULLTANKDETECTIONAREA.EPS/FULLTANKHANDLING.TIF
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Double Bounce

C-12

A double bounce echo is an echo that has been reflected against the tank roof
and down to the surface before it is detected by the transmitter.

Double bounces are most commonly present in spherical or horizontal
cylinder tanks. The tank roof in this case can sometimes amplify the double
bounce echo amplitude. Normally double bounce echoes appear when the
tank is about 60-70% filled. In these cases the double bounce echo can cause
the transmitter to lock onto the wrong echo.

The Double Bounce function is used for managing problems with echoes that
appear in the tank as a result of the tank shape and that are stronger than the
surface echo itself.

The Double Bounce Offset is given by the following formula:
Double Bounce Offset=B - 2*A,

where A is equal to the distance from the Tank Reference Point to the product
surface, and B is equal to the distance from the Tank Reference Point to the
Double Bounce echo. In many cases the Double Bounce Offset is
approximately given by the height of the nozzle.

DOUBLEBOUNCE.EPS/DOUBLEBOUNCE.TIF
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Surface Echo Tracking The Surface Echo Tracking function can be used to eliminate problems with
certain types of ghost echoes below the product surface. This may, for
example, occur in Still-pipes because of multiple reflections between the pipe
wall, flange and antenna. In the tank spectrum these echoes appear as
amplitude peaks at various distances below the product surface.

To activate this funciton select the Always Track First Echo check box. Make
sure that there are no disturbing echoes above the product surface when this
function is activated.
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Hold Off Setting

F1 Surface

— Hold Off

P1 Surface

c-14

The Hold Off parameter is set to a default value which rarely needs any
adjustment (see “Hold Off Distance” on page C-2 for definition of Hold Off
distance). The Process Seal antenna is slightly more affected by disturbances
in the nozzle than the cone and rod antennas. If necessary a small Hold Off
adjustment may be sufficient to solve the problem.

In a typical situation a small object such as a weld joint may give rise to a
disturbing echo. If this disturbance is strong enough the transmitter may
misinterpret this echo as the product surface. By setting the Hold Off large
enough to avoid measurement within and close to the nozzle, the problem is
solved as illustrated below.

The Spectrum Plot function in Rosemount Radar Master (RRM) allows you to
easily adjust the Hold Off distance:

1. In RRM click the Spectrum Plot icon to
SPECTRUM ANALYZER open the Spectrum Analyzer window.

2. Select the Configuration Mode tab.

3. Click the Read button and study the
amplitude versus distance graph. If
there is a disturbance caused by an

F3 Unknown object in the nozzle, the transmitter
may misinterpret the position of the
surface as shown to the left. In this
example the true surface position is at
amplitude peak P3.

12 14 16 18 20 2

4. Move the Hold Off distance line away
from the transmitter i.e. to a position
Hold Off below the nozzle.

5. Click the Store button.

F3 Urknowrn

P2 Urkno

12 14 16 18 20

6. Now the transmitter disregards any
disturbing echoes in the nozzle and
finds the product surface.

F1 Surface

P2 Urknowrn

12 14 16 18 20
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